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UvOD

Zahvaljujemo se vam za nakup nasSega laserskega stroja. Vas laserski stroj je podjetje DBK
d.o.0. pomagalo proizvajacu dovrSiti na visok nivo kvalitete. Stroj vas bo navdusil z
enostavno uporavo in niskimi stroski vzdrzevanja. Pred uporabo tega stroja pazljivo preberite
navodila in jih tekom dela skrbno uporabljajte, saj vam bo v pomoc¢ pri vzdrzevanju in
delovanju stroja.

Ker se zavedamo, da uporabnik med svojo uporabo sroja najblj opazi prednosti in morebitne
pomanjkljivosti vas prosimo, da nam sporocite vaSe predloge, ki jih bomo z veseljem
upostevali.



Varnostno opozorilo!

Pred samo uporabo stroja morajo uporabniki laserja skrbno prebrati to navodilo.
Operater mora vedno uporabljati ustrezna zasc¢itna ocala za CO2 laserski stroj!

Strogo se drzite predpisov za uporabo. Ljudjem, ki niso usposobljeni za delo s strojem,
uporaba stroja ni dovoljena. Stroj ima laser razreda 4 (moc¢ni laserski zarek). Taksno lasersko
sevanje lahko ob neposrednem stiku povzroc¢i naslednje nesrece:

- gorljive snovi se ob stiku z laserskim zarkom hitro vnamejo,

- razliéni materiali, ki jih obdelujemo lahko povzrocijo drugacna sevanja, strupene pline in
Skodljive snovi. Neposredni direktni laserski Zarek bo povzro€il telesno poskodbo (opeklino).
Lokacija stroja mora biti opremljena s protipozarno opremo (v bliZini laserja mora biti
gasilski aparat!

Prepovedano je graviranje na vnetljive in eksplozivne materiale, prav tako jih je imeti v
blizini laserja. Neusposobljenim delavcem je delo z laserjem strogo prepovedano!

Uporabnik naj skrbno preuci, ali so materiali, ki se obdelujejo z laserjem primerni za delo z
njim ter e je delo na laserju tvegano zaradi plinov, ki se spros¢ajo ob graviranju ali rezanju.
Materiale, na katerih ni posebej navedeno, da so primerni za laserski stroj preverite pri
prodajalcu materiala, kaj se sproSca pri gorenju. Kajti na trgu se pojavljajo materiali, ki pri
gorenju-rezanju-graviranje sproscéajo strupene pline.

V laserskem stroju je visoka napetost in druge potencialne nevarnosti.
Neusposobljenim upravljavcem ni dovoljeno posegati v stroj!

Upravljavec nikoli ne sme zapustiti stroja med njegovim delovanjem. Izklopiti mora stikalo za
vklop, ko kon¢a z delom. Ne odpirajte pokrival/vrat med delovanjem stroja. Pred
delom/uporabo mora biti stroj ozemljen!. Strogo je prepovedano graviranje materialov, ki
odbijajo svetlobo (ogledala in podobno), ker lahko povzrocijo pozar na predmetih okoli stroja
in poskodujejo stroj.

Upravljavec mora previdno opazovati delovanje stroja. Ce se pojavi napaka mora nemudoma
izklopiti stroj.

Lokacija stroja:

Stroj mora stati fiksno na suhem,Cistem obmocju, kjer ni mo¢ne elektrike in magnetizma.
Temperatura mora biti 5-40°. Okoljska vlaga bi morala biti 5-95% (brez zgoScene pare).
Priporoc¢eno je, da se poleg stroja uporablja elektro filter, ki izni¢i sunke oz nihanja
el.napetosti, ki lahko povzro¢i neenakomerno delovanje stroja.

Normalna napetost: AC230V, 50 Hz, prepovedano je odpreti stroj, ¢e je napetost elektricnega
toka neenakomerna ali slaba.

Proizvajalec ne bo prevzel odgovornosti zaradi nepravilne uporabe stroja oz. neupostevanja
zgoraj omenjenih predpisov s strani uporabnika.

VZDRZEVANJE Laserskega stroja:

Vodila je potrebno vsakih 7 dni dela temeljito po¢i z razreCilom in kasneje namazati z
vizkoznim teflonskim mazivom.

Gumjaste jermene je priporocljivo vsaki mesec poskropiti s sprejem za vzdrZzevanje plastike
in gume.

LECO je potrebno &istit vake 3 delovne dni z vatiranimi palékami in Gistim alkoholom.



Nikoli ne cistite leCe z agresivnimi tekocinami!
Odsesovalni sistem je potrebno Cistiti vsake 3 mesece, kajti zaradi smole in dima se lahko
zamasijo reSetke na vetilatorjih.

1. poglavje: Videz stroja in dodatki
1.1.1. Videz stroja (razli¢ni model bo imel drugacen videz na podlagi realnega objekta).
Pravilna stran

F1-1

Hrbtna/zadnja stran je prikazana na sliki F1-2.

F1-2



1.1.2 Dodatna oprema
Dodatna oprema vsebuje naslednje dele (razen opcijske rezervne dele):
Indusrijski hladilnik CW3000 ali CW5000-CW 5200, kot prikazuje na sliki F1-3:

ALARM NORMAL

F1-3

V hladilni sistem se nalije destilirana voda z dodatkom antifiriza (8litrov
destilirane vode in 2dcl antifiriza za hladilne sisteme).

Novo vode je potrebno kontrolirati vsakih 30 dni in po potrebi doliti.



Vodo je potrebno menjati vsakih 6 mesecev ali po potrebi pred¢asno.

Priklop hladilnika na laser je sledec:

Izhodna cev za vodo na hladilniku gre na laserj na vhod za vodo in izhodna cev
na laserskem stroju gre na hladilniku na vhod.

2. Sesalni ventilator in dimna cev sta prikazana na sliki F1-4

F1-5
Laserska cev mora biti vedno ¢ista in brez prahu. V kolikor se nabere prah na
cev jo je potrebno ocistit.

Navodilo za ¢iSCenje:

Laser izkljucite iz elektricnega omrezja in pocakate vsaj 30 min, ker lahko v
el.komponentah ostane el.naboj.

Potem z Copicem ali kompreorjem izpihate prah iz tube.

1. Hladilnik je prikazan na sliki F1-6:

F1-6



2. Priro¢na torba in notranji dodatki so prikazani na slikah F1-7, F1-8.

F1-7 N F1-8

6. Zica za ozemljitev je prikazana na sliki F1-9 (kupec jo mora namestiti sam)

I 2. poglavje: namestitev in priprava stroja

Laserski stroj je sestavljen iz laserske CO2 Zarnice, hladilnega sistema (hladilnik CW3000,
CW5000 ali CW5200), kompresorja za izpihovanje laserske glave, odsesovalnega ventilatorja
USB ali mreznega kabla za prenos podatkov na stroj, satovja, napajalni kabli. Glede na zeljo
uporabnika se lahko ob nabavi stroja dobavi tudi racunalnik.

2.1 Koraki namestitve in nastavitve laserske cevi

1. Namestitev laserske cevi
Namestitev laserske cevi lahko opravi le pooblas¢en serviser!

Namestitev vodne Crpalke

Prosimo, nalijte ¢isto vodo v vodni bazen (raven vode naj bi bila visja vsaj od cevi). Odvodna
¢rpalka naj bi bil povezana z dovodno odprtino stroja in drugi del vodne ¢rpalke naj bo
povezan z odvodno odprtino stroja. Drugo stran vodne cevi dajte v vodo in zakljucite krozeco
povezavo vodne cevi.

Kakor prikazujeta sliki F2-7 in F2-8, prikljuci napajalnik vodne ¢rpalke, zdaj lahko vidimo,
da se laserska cev postopoma polni z vodo. Ce voda tekode tece skozi odvodne cevi, to
pomeni, da ¢rpalka deluje pravilno. Za zagotovitev normalnega pretoka hladne vode skozi
lasersko cev, je v vodnem reciklaznem sistemu names¢en vodni za$citni senzor. Med slabim
delovanjem vodnih ¢rpalk, se bo laserski stroj za graviranje samodejno preklopil v zascitno
stanje. Laserska cev ne bo oddajala laserske svetlobe. Zato bodite pri vzdrzevanju rutine
pozorni na €iste vodne ¢rpalke in vodne cevi.



2. Namestitev kompresorja

Zracna cev naj deluje kot povezava za izhajanje zraka iz Crpalke in njegovo vstopanje v
stroj za graviranje. Poskrbite za normalno prezracevanje po vklopu/vzigu, kot je to
prikazano na slikah F2-9 in F2-10.

r

F2-9 F2-10

V tem sistemu ima zracna ¢rpalka izreden pomen. Visoko napetostni zrak se giblje skozi
zraéne cevi in piha skozi okno laserske glave, ki oddaja lasersko svetlobo. Po eni strani
lahko zagotovi Cisto¢o, po drugi strani pa lahko prepre¢i vnetljivost snovi laserske
svetlobe. Zato mora upravljalec pozornost nameniti zracni cevi. Poskrbeti mora za to, da
ta ni ukrivljena ali poskodovana, drugace lahko odvecen zrak vodi do gorljivih snovi.

3. Namestitev sesalnega ventilatorja

Dimna cev mora povezovati sesalni dovod ventilatorja z odprtino laserskega stroja, ki
izsesava prah. Vse tri fiksirajte s kljucavnico. Vzamite drugo dimno cev in jo poveZite s
sesalnim odvodom ventilatorja. Drugi konec dimne cevi naj ostane nepovezan/mora
gledati navzven. Za konec dobro prikljucite napajalno Zico, kot je prikazano na slikah F2-
11 in F2-12.

F2-11 F2-12

5.Varna ozemljitev

Laserski gravirji tehnologije Morn uporabljajo Stiri vrstno lasersko cev. Pogon je visoko
napetostni, zato morajo upravljavci stroja med njegovo uporabo upoStevati varnostna
opozorila. Po drugi strani zahtevajo varnostna navodila od upravljalca, da se strogo drzi
pogojev/zahtev varne ozemljitve. Napetost/odpornost tal mora biti manj kot 5 Ohmov.
Specifi¢na metoda prikljucutve/povezave je prikazana na slikah F2-12 in F2-13.



Opozorilo: slaba ozemljitev lahko povzroc¢i veliko verjetnost nedelovanja opreme in hkrati
druge vranostne incidente!!! Podjetje ne bo prevzelo nobene odgovornosti ali obveznosti v
primeru napake ali nesrece zaradi slabe ozemljitve.

Opti¢na pot

Vsi napajalni vodi naj se povezujejo in napajajo z elektricnim tokom. Vklopite napajalnik
gravirnega stroja. V tem casu se stroj zazene ponovno in vrne na zadnjo izvirno to¢ko. Vse
zgoraj kaze na to, da stroj deluje normalno. Sprozi laserski napajlnik in za¢ni z uravnavanjem
opti¢ne poti, kakor kaze slika F1-14:

F2-14

Uravnavaj nastvavitev laserja. Zaloga vecslojnega papirja naj bo na uokvirjenem zrcalu. Nato
pritisnite tipko »Pulse« na nadzorni plosc¢i. Na papirju se pojavi zaZgana tcka. Preverite, ali je
svetloba na sredini zrcala. Ce svetloba ni na sredini zrcala, jo moramo postaviti na sredino
zrcala, tako da reguliramo lokacijo (uravnavamo lego) laserske cevi.

Potem regulirajte odbojna zrcala (reflektorje). Zarke pomaknite, tako da bodo najblizje
reflekorju. Pritisnite »Pulse«, da se svetlobna tocka/mesto prikaze na papirju. Nato pomaknite
zarke dale€ stran od reflektorja in najdite Se eno to¢ko na papirju. Kote zrcal uravnamo tako,
da poravnamo vse tri vijake na hrbtni strani zrcala (vrtenje zgornjega vijaka v smeri urinega
kazalca, toCka/mesto bo spodaj; vrtenje spodnjega levega kota vijaka, svetlobna tocka se
pomakne na levo), da zagotovimo, da so vse tocke na papirju na pravem mestu in kdaj ter kam
pomikamo Zarek.

Potem ko dobro uravnamo zrcalo reflektorja, moramo nato uravnati zrcalo, lasersko glavico
pomaknemo najblize reflektorju. Nato doloCimo svetlobno tocko na papirju. Naslednjo
mesto/tocka se mora prekrivati s prvim mestom/tocko. To naredimo, tako da vrtimo vijake na
okviru reflekorja.



Opozorilo: najboljse je, da je lokacija svetlobne tocke na sredini zrcal. Svetlobna tocka se ne
sme dotikati robov zrcal. Ce pa se znajdejo na robovih, potem Se naprej uravnavajte zrcala,
dokler se svetlobna tocka ne bo znasla na sredini zrcal.

Nazadnje moramo preveriti, ali so svetlobne tocke dobro postavljene, ne glede na lokacijo
laserske glave. Ce tocke ne sovpadajo, prosim, ponovno uravnavajte opticno pot na zgoraj
opisani nacin vse do sovpadanja/prekrivanja tock.

Po uravnavanju bomo preverili, ali je ta laserska tocka na sredini svetlobnega jaska laserske
glavice. Ce temu ni tako, izklopite laserski napajalnik in prilagodite nastavitev laserske cevi.
Ali gre za levi ali desno odklon- ne glede na to pomaknemo lasersko cev na tisto stran, na
katero je nagnjena. Na primer, ¢e je nagnjena na levo stran, jo pomaknemo na levo, ¢e pa na
desno, pa jo pomaknemo na desno stran.

Ce nagibanje niha, moramo lasersko cev povleci na nasprotno stran. To pa pomeni, da se
nagiba gor, povlecemo lasersko cev dol, ¢e pa gor, bomo povlekli lasersko cev gor.

Opozorilo: zgoraj opisana navodila za uravnavanje laserske cevi so misljena samo za nizko
napetostno stran laserske cevi (svetlobna stran). Ko pa Zelimo doeseci isti uCinek z
uravnavanjem visoko napetostne strani, potem je smer uravnavanja nasprotna.

Za podrobne informacije o tem, kako uravnamo opti¢no pot, glejte poglavje 4 (uvrstitveni
standardi opti¢ne poti).

Po uravnavanju opticne poti, prosim zaprite zas¢itno pokrivalo laserske cevi.



3. Poglavje

Upravljanje z laserskim strojem

Poleg racunalnika za nadzorovanje tipke (gumbe) delovanja lahko uporabljamo nadzorno
plosco. V nadaljevanju vam bomo predstavili nadzorno plos¢o in njeno glavno funkcijo.

Nadzorna plosca ima 16 tipk delovanja/funkcijskih tipk in en LCD zaslon.

Predstavitev vmesnika
1.3.1
Glavni vmesnik 1 (ne deluje)

Datoteka FILE ¢ XXX
Maksimalna mo¢ : XX.X%

Hitrost : XXXmm/s
Nedelujoc ...

Glavni vmesnik 2 (deluje)

Datoteke : XXX
Maksimalna moc¢ : XX. X%

Hitrost delovanja : XXXmm/s
Delovanje : XX : XX : XX



Glavni vmesnik 3 (pavza)
Datoteka ¢ XXX
Maksimalna mo¢ : XX.X%

Hitrost delovanja : XXXmm/s
Pavza : XX :XX': XX

Ko stroj ne deluje, se pojavi vmesnik 1. Navzoca datoteka (ki se pojavi) vam bo pokazala
»000« (to pomeni, da ne izberemo spominske datoteke). Videli bomo najve¢jo mozno moc ter
hitrost graviranja na zaslonski plosCi, to je najve¢jo mozno porabo energije, izrazeno v
odstotkih, ki ustreza natan¢no 0.1 % in hitrost z enoto v mm/s. Seveda lahko pritisnemo tipko
pod 1. glavnim vmesnikom, toda nekatere tipke/gumbi pod 2. in 3. vmesnikom ne bodo
delovale.

1.3.2 Predstavitev gumba
Ponovni zagon

Stroj se bo zagnal v vseh stanjih. Glavni ra¢unalnik se bo zagnal in stroj se bo vrnil v prvotno
stanje in deloval, zaslon LCD pa bo prikazal »ponovni zagon sistema«. Po uspesni vrnitvi v
prvotno stanje, se bo stroj vrnil na zadnje prvotno stanje. Ce bo zadnja naloga/delo
dokonéano, se bo na zaslonu pojavil prvi glavni vmesnik. Ce zadnja naloga ne bo dokonéana
(stroj ni bil zagnan med delovanjem), bo sistem prikazal naslednje:

Power Off Rework (zaustavljen, ponovno delo)

OK (v redu)
Esc (tipka Esc ali nazaj)

Ce pritisnemo tipko Esc (nazaj), stroj ne bo deloval sproti. Sistem se bo vrnil 1. glavnemu
vmesniku. Ce pa pritisnemo »enter« (slov. vnesti), bo stroj nadaljeval z delom in graviral
sliko, ki pred izklopom stroja ne bo dokoncana. Pomnite, da potem ko pritisnemo »enter«, se
bo na LCD zaslonu pojavil zapis »iskanje tocke za zaustavitev sistema, prosim, pocakajte.«
Cakalni ¢as je povezan z zadnjo koli¢ino obdelanih podatkov. Vegja je koli¢ina podatkov,
daljsi je Gakalni &as. Ce je sistem zaustavljen, potem ko je graf eno uro obdeloval podatke,
traja iskalni ¢as eno minuto.

Laser

”aser

Ta gumb lahko pritla¢imo, ko je stroj v stanju mirovanja (nedelovanja) ali pavze. Ko
pritla¢imo to tipko, prihaja laserska svetloba iz laserske cevi. Cas oddajanja svetlobe se ujema
s Casom pritiskanja na tipko. V trenutku, ko pustimo tipko, laser preneha. S pritiskom in



usmerjanjem tega gumba lahko izrezujemo materiale. Laserska moc¢ je najvecja mozna moc¢
na LCD zaslonu. Gumb ni uporaben, ¢e je v drugem stanju. Med nedelovanjem sistema za
hlajenje vode ne bo laserja. Prav tako se bo na zaslonu LCD prikazalo obvestilo o napaki.

Parametri

Min Power — najmanjSa mozna mo¢

Max Power- najve¢ja mozna mo¢

Speed Hitrost

Obstajajo trije parametri: minimalna mo¢, maksimalna moc¢ in hitrost. Parametre
lahko prilagodimo vsem trem glavnim vmesnikom (nedelovanje, delovanje in
pavziranje?mirovanje?). Ko stroj deluje, lahko vidimo parametre na zaslonu LCD. Ko
programska oprema izrezuje/gravira datoteko, €e se eden od parametrov
(maksimalna mo¢, minimalna mo¢ in hitrost) oz. vsi parametri premaknejo na 0, bodo
ustrezni parametri na LCD zaslonu presli v stanje nedelovanja. Ko enkrat zachemo z
delom, se bodo pojavili parametri na LCD-ju.

Odlocite se na primer za hitrost (angl. speed). Ko boste pritisnili to tipko, se vam bo
na zaslonu prikazalo naslednje:

Hitrost: XXX mm/s
OK Or Esc
Vmesnik 5

Lahko se odlo€imo za parameter, ki ga zelimo uravnati s pritiskom na tipko, ki
usmerja levo ali desno, in potem spremeniti smer s tipko gor ali dol. Shranimo ga
lahko s pritiskom na tipko »O.K.« (ang. v redu). Prekli€¢emo ga s pritikom na tipko
»Esc«.

Pri paramatrih minimalna mo¢ (ang. min power) in maksimalna mo¢ (max power) je
podobno. V stanju nedelovanja vpliva sprememba moci in hitrosti na naslednje



parametre delovanja: zvok tipke, laser in ro¢no premiéno os. Spremeni te tri
parametre, ko stroj deluje in nato samo spremeni nadaljnji uCinek obdelovanja. Ne
vplivaj na parametre, ki so pod stanjem nedelovanja. To ne bo vplivalo na laZzeCe
parametre.

Spletno spreminjanje obdelovanja lezeCih parametrov prepri¢ajo uporabnike v to, da
se ustrezna laserska moc in hitrost pokrivata.

(4) Datoteka

Vidimo lahko spodniji zaslon, ko prtisnemo tipko datoteka, ko je stroj pod stanjem
nedelovanja:

MemoryFile Spominska datoteka
UdiskFile Udisketna datoteka
TrackFrame Sledi
Del All Memo File Zbrisi vso spominsko datoteko
Vmesnik 6 Vmesnik 6

Za datoteko se lahko odlo€imo z usmerjanjem tipke desno ali levo. Pritisnemo
»enter« za vpogled v naslednjo datoteko. »Datoteke« nam ne bo prikazal, ¢e ni
datoteke v »spominski datoteki« ali »u disketni datoteki«. Ce pa datoteka obstaja,
bomo videli ime in informacije na datoteki na zaslonu LCD. Na LCD zaslonu lahko
vidimo 4 datoteke:

XXX XXXXXXXX
XXX XXXXXXXX

XXX XXXXXXXX
XXXXXXXXXXX
Vmesnik 7

Izberemo lahko datoteko z usmerjanjem tipk (gor in dol se uporabljata za
spreminjanje toCke in leva in desna tipka pa za spreminjanje strani), nato
kliknemo »enter«, da vstopimo v naslednji vmesnik. V pomo¢ je naslednjim
Stirim funkcijam: »zaZeni«, »sledi«, »ToUsb«, »zbriSi«.



Run-Zazeni
Track Frame-Sledi
ToUsb- k usb

kljucu

Delete-Brisi

Vmesnik 8

Stroj bo obdelal preverjeno datoteko, ko bomo izbrali »zaZeni«, datoteko bo kopiral
na U disk, ko bomo izbrali »To Usb«, datoteka bo izbrisana, ko bomo izbrali »izbriSi«.
Za datoteke v U disku podpira dve funkciji, namre& »kopiraj« in »brisi«. Ce je kaj
narobe, lahko pritisnemo »enter« ali »esc« (»nazaj«), da jo shranimo ali preklicemo.

Glavna plo&¢a lahko prepozna formatne datoteke FAT 32 in FAT 16. Te datoteke
moramo vstaviti v korensko datoteko U disk. VeC kot osem znakovne datoteke se
samodejno prerezejo. Ime datotek mora biti sestavljeno iz Crk ali Stevilk. Datoteke, ki
se kopirajo iz mati¢ne ploSCe na U disk, se premestijo v korensko datoteko.

Opcija »sledi« (ang. »Track Frame«) Sestega vmesnika pomeni track border za
trenutno izbrano spominsko datoteko (zadnjo obdelano datoteko). Opcija »Track
Frame« 8. vmesnika pomeni track border za posamezno spominsko datoteko. Ce je
izbrana katera od teh opcij, se spodaj prikaze vmesnik:

Blank X.XX mm
CutFrame

TrackFrame

DotCorner
Vmesnik 9

Pojdite v vmesnik 9, drsnik se nahaja v privzeti prvi opciji »prazno« ali (ang.
»blank«- prazno pomeni zunanjo razdaljo na podlagi dejanske velikosti grafa).
V tem casu lahko namestimo »prazno«, tako da pritisnemo na pusCice. Nato
pritisnemo »enter« ali »esc«, da nastavimo ali prekli¢emo namestitev. Potem ko
nastavimo prazno razdaljo, se bo drsnik vrnil v »prazno«. Izberemo lahko druge
opcije, tako da pritisnemo na puscici za navzgor in navzdol. Z opcijo »izreZi«
lahko izrezemo konc¢ni graf z rokami. »Sledi« pomeni, da se premikamo po
meji, da doseZemo okvirni predogled. Opcija »DotCorner« pomeni, da bo laser
oddajal svetlobo v Stirih mejnih kotih. Skozi teh §tir1 mest bomo lahko opazovali
grafi¢no velikost in lokacijo. V tem cCasu sta gibalna mo¢ in laserska moc¢ stroja
nastavitve, ki se pojavijo na LCD-ju, ko sistem ne deluje. Laserska moc
»DotConor« je samo povezana z maksimalno moc¢jo (angl. Max Power).

Opozorilo: Ce je graf prevelik oz. se lokacija nahaja koordinatah max/min,
lahko meja preseze koordinate max/min. Na tej tocki bo vmesnik pokazal prevec
informacij. Potem ko pritisnemo »enter« bo sistem sledil okviru v skladu s



koordinatami max in min. Za »rd.«, to je datoteka, ki je produkt starejSe
programske opreme, bo vmesnik pokazal »ni okvirnih informacij pri upravljanju
z datoteko rd.«. Ko bomo uspe$no zaceli uporabljati mejo, bo vmesnik pokazal
DIECRREIRENER. V tem casu se prikazovalnik ne bo odzval na katere koli
druge gumbe, razen na »ponovni zagon« ali »reset«.

(5) ZaCni/miru;j

Start-
Pause

Zacni/miruj lahko pritisnemo v treh glavnih vmesnikih. Prtisni to tipko, ko
sistem ne deluje. Obdelal bo izbrane datoteke. Pritisni to tipko, ko stroj deluje, delo
bo mirovalo. Pritisni to tipko v vmesniku mirovanja in delo se bo nadaljevalo.

(6) lzvor

To tipko lahko pritisnemo, ko je sistem v stanju nedelovanja. Racunalnik bo prevzel
os X/Y trenutnih strojev kot zaCetno delovno toCko. Ta tipka ne velja za druge
vmesnike.

(7) Jezik

Vmesnik Clovek-stroj podpira tri jezike. Ko sistem ne deluje, pritisni tipko »jezik,
vnesi jezike. Obstajajo trije jeziki: poenostavljena kitajS€ina, tradicionalna kitajs€ina in
angle&cCina. Izberi jezik in pritisni »enter«, LCD bo potem prikazal ustrezen jezik. Kerv
naslednjem jeziku ni spremembe, bo nazadnje izbran jezik obveljal pred naslednjo
spremembo jezika (ponovno zazeni stroj).

Esc Enter

Pritiskanje tipk Esc ali Enter lahko potrdi ali prekliCe delovanje v vsakem
vmesniku.
Smerokazne tipke (gor in dol, levo in desno).

(A) (W) [¢=] (m)

Smerokazne tipke se uporabljajo, da spremenimo parametre, premikamo os.
Pritiskamo lahko smerokazne tipke, da premikamo os v nedelovanju ali mirovanju.
Premikanje osi X na levo ali desno tipko in premikanje osi Y s pritiskanjem na tipki
gor in dol. Najve€ja mozna hitrost premicne hitrosti s pritiskom na tipko je hitrost na
zaslonu LCD, ko je sistem pod stanjem nedelovanja.

10 Z/U tipka




Z/U tipka je na voljo v stanju nedelovanja. Spodnji vmesnik bo prikazal
naslednje po prtisku na tipko:

Z.AexsMove
UAexsMove

Z.AexsReset
ManualSet
Vmesnik 10

Lokacijo drsnika lahko spremenimo s pritiskom na smerokazne tipke gor
in dol. Ce drsnik ostane v premiku “ZAeksMove”, se bo os ob pritiskanju na
tipko za desno in levo smer premaknila.

Ce je premiéna razdalja v koraku ni¢, se bo os Z kontinuirano gibala ob
prtiskanju leve in desne tipke. Premik “UaeksMove” je podoben premiku
“ZaeksMove”. Ko drsnik izbere opcijo ponovnega zagona “ZaeksReset”, pritisni
“enter” in sistem bo zacel premikati os Z nazaj v prvotno stanje, vmesnik pa
vam bo pokazal, da se je je os Z ponovno zagnala. Po kon¢anem zagonu osi Z in
uspesni vrnitvi v prvotno stanje, ima os Z za$¢ito koordinat Max in Min, tako
kot os X/Y. Os Z samodejno pospesuje in zavira, ko se premika v koordinatah
Max in Min. delovne mize. Ko drsnik izbere opcijo “nastavi korak™, pritisni
“enter” in vmesnik pokaZe naslednje:

Step Moving Distance/Premic¢na razdalja v koraku
XXX.Xmm
Vmesnik 11

Nastavimo jo lahko s pritiskom na pus¢ice. Niz premi¢ne razdalje v
koraku vpliva na delovanje in na razdaljo v koraku Stirih osi X/Y/Z/U.



4. poglavje
Nastavitveni standardi opti¢ne poti

Med obic¢ajno uporabo lahko pride do odstopanja opti¢ne poti in s tem
posledi¢no tudi do nenormalne poti svetlobe ali do nepojavljenja laserja.

Prvi korak: najprej poskrbi za potovanje laserskega zarka od laserske cevi
do sredine prvega odsevnega zrcala/reflektorja.

Drugi korak: zalepi ve¢slojni dvojni lepilni trak na drugi reflektor (ali
oznaci druge predmete), laserski Zarek priblizaj laserski cevi, pritisni pulz (utrip)
(izberi primerno moc), izberi mesto na papirju (posebno opozorilo: najpre]
testiraj priblizno lokacijo svetlobne tocke s kartonom, da preprecis slabo
lasersko sevanje in nato uravnavaj).

1#
laser tube [::I

Uy, 34

A

Tretji korak: Zarek
premakni na mesto, ki je zelo oddaljeno oddaljeno od laserske cevi, pritisni pulz in
najdi $e drugo mesto na papirju.



1#
;&:ﬁ laser tube E:]

Y

|
Wi, 3%
24
A#

Cetrti korak: ¢e tocki ne leZita ena nad drugo, uravnaj vijake na
zadnjem delu prvega reflektorja, tako da bi laser meril na tisto mesto, kjer je prva
toCka.

Peti korak: ponovi korake od 2 do 4, tako da se bosta toCki popolnoma
ujemali/prekrivali. Poleg tega naj bodo toCke na sredini luknje.

Sesti korak: na tretji reflektor prilepi ve&slojni dvojni lepilni trak, lasersko glavo
priblizaj drugemu reflekorju (zrcalu), pritisni pulz (izberi ustrezno moc€) in pois¢i tocko

na papirju.
I?e:j laser tube I:::I

L 4

A4

Sedmi korak: lasersko glavo pomakni na mesto, ki je najbolj oddaljeno od
drugega reflektorja, pritisni pulz (da najprej odkrijeS ustrezno lokacijo laserja s
kartonCkom, da se prepreci slabo sevanje), nato poisci drugo tocko/mesto.

3#
2#

A#



Osmi korak: Ce ti dve toCki ne lezita ena nad drugo, uravnavaj/privij vijake na
zadnji strani drugega reflektorja, tako da bo laser meril na isto mesto, kjer je prva
toCka.

Deveti korak: ponovi korake od 6 do 8, tako da se bosta toCki popolnoma
prekrivali. Poleg tega morata biti tocki na sredini luknje.

Deseti korak: na tretji reflekor prilepi vecslojni dvojni lepilni trak, pritisni pulz in
poiSc¢i tocko na papirju. Ce je ta na sredini svetlobne tocke, jo obidi.

Enajsti korak: Ce laserska svetloba ni na sredini svetlobne toCke, kakor kaze
spodnja slika, je treba narediti naslednje:

Na levi sliki se totka nahaja zgoraj desno. Ce se to¢ka nahaja zgoraj na vrhu ali
spodaj na dnu, lahko to dvigne oziroma spusti lasersko cev. Lasersko cev pritisnite
navzven ali navznoter. S tem uravnavate teZzenje toCke navzen ali navznoter. V tem
primeru je dobro spustiti lasersko cev (to je povezano z nizkonapetostno stranjo
laserske cevi) in nato od zaCetka ponovite prvi korak.

Opozorilo: upravljavec ni zmozen izvesti zgoraj opisane korake, ¢e ni strokovno
usposobljen. V drugaCnem primeru mora upravljavec izvesti ta dela s pomocjo
strokovnjaka. Upravljavec mora med uravnavanjem pozornost nameniti varnosti, da
prepreci slabo lasersko sevanje.



4. poglavje Dnevno vzdrZevanje in obiCajne napake

Stabilno delovanje stroja je tesno povezano z normalnim dnevnim delovanjem in
vzdrzevanjem. Tu je podana anliza obiCajnih napak in obiCajnega dnevnega
vzdrzevanja:

1.5.1 Dnevno vzdrZevanije:
1. Zamenjava hladilne vode (Cisti vodni bazen in zamenjava reciklirane vode enkrat
dnevno sta priporocljiva).

Kakovost in temperatura hladilne vode lahko neposredno vplivata na Zivljenjsko dobo
laserske cevi. Zato predlagam uporabo preciSCene in destilirane vode. Temperatura
vode mora biti nizja od 35 stopinj in Celzija. Ce je temperatura vi$ja od 35 stopinj in
Celzija, zamenjaj hladilno vodo in dodaj ledene kocke ter zmanjSaj temperaturo vode

(priporoc€a se hladilna naprava ali uporaba dveh vodnih bazenov).

Opozorilo: poskrbi za to, da je laserska cev napolnjena s hladilno vodo pred
delovanjem stroja.

2. Cisgenje vodnega bazena

Najprej izklopi stroj, prekini dovodno cev in samodejno spuscaj vodo iz laserske cevi
v vodni bazen, nato odpri vodni bazen, izvzemi vodno &rpalko in jo o€isti. OcCisti tudi
vodni bazen, vstavi vodno cev, ki povezuje vodno ¢rpalko z dovodno odprtino stroja,
zatisni vse Clene in zamenjaj hladilno vodo. Posebej/na samem vklopi vodno &rpalko
in jo pusti delovati od 2 do 3 minute (laserska cev naj bo napolnjena z vodo).

3. Ciséenje izpusnega ventilatorja

Po dolgoro¢ni uporabi se znotraj ventilatorja nabere trdi prah. Tako nastane zaradi
ventilatorja hrup, ne pa posledi¢no tudi iztroSnja. Ko izpraznovanje postane slabo,
moramo pocistiti ventilator in dimno cev. Najprej izklopi izpusni ventilator, obe cevi
odstrani z ventilatorja, pocCisti prah znotraj cevi in nato Se prah znotraj ventilatorja.

4. Cis&enje le¢ (priporogdljivo je dnevno &i$&enje pred delom, oprema mora mirovati)
Kot smo Ze omenili prej, mora imeti rezalni stroj tri reflektorje in objektiv (prvi reflekor
je v blizini odprtine laserske cevi, iz katere izhaja svetloba, zgornji levi kot stroja,
drugi reflekor je na levi strani zarka, tretji pa na vrhu laserske glave, objektiv pa se
nahaja na dnu laserske glave). Laser nastaja pod vplivom reflektorja (zrcala, ki
odseva) in objektiva, ki zaostruje. Zrcalo zlahka postane umazano, kar posledi¢no
vodi do izgube laserja in poSkodbe zrcala. Med CiSCenjem vam ni treba premakniti
prvega, drugega in tretjega zrcala. Vzamite samo bombazni kos oblacila in ga
namocite v raztopino (aceton ali alkohol). Previdno pobriSite zrcalo, tako da kos
oblacila vrtite od sredine leCe do njenega roba.

Izvlecite objektiv iz laserske glave, ocistite ga na enka nacin in ga po CiS¢enju
vstavite nazaj.

Opozprilo: previdno obriSite leCe, ne smete poSkodovati povrSinske previeke. To
naredite narahlo, da leCe ne padejo. Pri nastavitvi objektiva naj bodo konkave
pomaknjene navzdol.



5. Cid¢enje tracnice (priporota se CiSenje dvakrat tedensko, oprema mora
mirovati).

Najprej pomakni lasersko glavo na skrajno desno (levo), obriSi jo s suho krpo in malo

olja, tako da bo sijala (priporo€a se olje za Sivalni stroj), lasersko glavo nekaj krat

pocasi potiskaj po traCnici, tako da se mazivo razporedi enakomerno. OCisti in

namazi obe tracnici, tako osi Y kot osi X.

Opozorilo: Prosim, za CiS€enje pripravi: suho bombazno krpo in mazivno olje.

6. Pregled opti¢ne poti

Sistem optiCne poti laserskega rezilnega stroja se kon€a z odsevanjem zrcala in
zaostritvijo objektiva. OptiCna pot je nagnjena k objektivu, toda vse tri zrcala so
pritrjiena z mehani¢nim delom. Obstaja verjetnost, da bo opti¢na pot nagnjena k
zrcalom. Kljub temu te nagnjenosti/teznje opticne poti obi¢ajno ni, zato vam pred
delom predlagamo pregled opti¢ne poti.

Podrobno razlago o tem si preberite v 4. poglavju »Nastavitev standardov optiCne
poti«.

Analiza obi€ajnih napak

Pojav/mozno
St. slabo Metoda analize Resitev
delovanje
Preveri, ali napajalnik stroja | Ponovno elektriziraj
, .| dcbro prevaja napajalnik.
Odpri stroj . .
1 , . Popravi parametre na podlagi
brez premika | Parameter glavne plosce je ,
) ) navodil za uporabo
pravilen ali ne
programske opreme.
Delo s Y Popravi parametre na podlagi
, Parameter glavne plosce je ,
2 stalnim , . navodil za uporabo
, pravilen ali ne
laserjem programske opreme.
Slab Preveri, ali je krozenje vode | Ocisti vodni bazen, vodno
aba
plavajoce ali ne ¢rpalko in vodno cev
3 | svetloba med ) )
] ) i , Dodaj regulator za laserski
delovanjem | Napetost je stabilna ali ne ,
stroj
Samodejni . o
test na Popravi smerost Xin 'Y,
y Parameter glavne plosce je parametre nastavi glede na
4 zacetku/ob . , . :
pravilen ali ne. priro¢nik delovanja
zagonu
programske opreme.
abnormalen
5 Po Preveri, ali je mesto podatkov | Izberi pravilno mesto.




uporabi/nasta | pravilno.
nku podatkov | Preveri, ali je stroj vklopljen | Vklopi stroj
stroj ni Preveri, ali je zemeljska Zica . , .
L , Priklopi zemeljsko Zico.
deloval za stroj priklopljena.
Preveri,
ali je nastavljen USB Nastavi USB gonilnik
gonilnik
. . Preveri, ali je opti¢na pot L
Ni laserja , 1= 0P P Nastavi opti¢no pot
med nagnjena
delovanjem | Preveri, ali hladilna voda te¢e | Poskrbi za tok vode
Ni mogoce
odkriti problem komunikacije prek

lasersko
opremo

raCunalnika ali USB-ja.

Zamenjaj racunalnik ali USB




I RDCAM V3.0 Navodila za uporabo
Il 1. poglavje Pregled
Il. 1.1 Predstavitev laserskega sistema za garviranje in rezanje

Laserski sistem za graviranje in rezanje doseze ucinkovit nadzor z raCunalnikom, to
je odvisno od razlicnih pogojev dokonfanja obdelav. Sistem vklju€uje nadzorni
racunalnik in plosco, ki sta v pomoc€ programski opremi. Ta priroCnik opisuje uporabo
programske opreme za dokoncanje laserske obdelave (za ZiCenje maticne plosce in
delovanje nadzorne ploS€e poglej prilozen priro¢nik in navodila za upravljanje z
ZiCenjem nadzorne plosce).

Programsko podprti datoteCni formati:
Vektor format: dxf, ai, plt, dst, dsb... itd.
Bitmap format: bmp, jpg, gif, png, mng... itd.

Il. 1.3 Zahteve okolja
e Windows 2K/XP/Vista, win7 XP priporocljiv
e Above CPU586, above PIIl in PV priporocljiva
e Spomin, priporoCa se had 1 G

2. poglavje Nastavitev programske opreme
Nastavitveni koraki

Dvakrat klikni Setup.exe pod imenikom za nastavitev in pojavil se bo naslednje
okence:

Welcom to use{XCiH {3 H )

In=tall Driver/dE=hEdE

Type/ il |C orelllraw_Laser ﬂ

Lanmage/ i8S |Eng;li sh ﬂ

[ Locate install path/ENEHEIEE

Inztall/3F8 | Exit/iEH |

Klikni (nastavi gonilnik), da nastavis USB zagon:
Ce se pojavijo informacije o nastavitvi strojne opreme, izberi nadaljuj, dokler
nastavitev ni dokon¢ana.



Hardware Installation

L] E The =aoftware wou are inztalling far this hardware;
L

I15EB Sernial Convverter

haz not passed ‘Windows Logo testing to werify it compatibility
with "Windaws =P, [Tell me why this testing iz important. |

Continuing your installation of this software may impan
or destabilize the comrect operation of your zystem
either immediately or in the future. Microzoft strongly
recommends that you stop thiz installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

[ Continue Anyway ] EéTDF'Installatinn |

Po nastavitvi se pojavi naslednje okence, ki kaze na uspeSno nastavitev USB
gonilnikov.

Ll
\l‘) FTDI drivers have been install successfully installed!

Izberi vrsto in jezik, kot kaZe spodnja slika:

Welcom to use{XCiH {3 H )

Install Driver/3EshaEdE |

Type/2E8] |La5 erffork ﬂ
Lanuage/i85: |English ]|

[ Locate install path/TEfIZHERET

Exit/iEH |




Klikni nastavi. Po nastavitvi se pojavi naslednje okence s podatki o uspesni nastavitvi
programske opreme.

RLaserSetlip E|

\]:) Install Finish!

IT 3. poglavje Osnovno delovanje programske opreme
Delovanje glavnega vmesnika
Po zagonu programske opreme se vam na naslednji sliki prikaze vmesnik

Meoniiek Sistemska Vrstica za rezanje
cenyska vrstica
vrstica
Vrstica za
»| urejanje
Nadzorna P

plosca




Menijska vrstica: glavna funkcija te programske opreme je na voljo v menijski vrstici.
Menijska vrstica vsebuje dokument, popravi, narisi, nastavitev, obdelavo, pogled in pomoc.

Sistemska vrstica: v sistemski vrstici najdemo najpogostejse ukazne gumbe iz menija.

Vrstica za urejanje: privzeta vrstica urejanje je na levi strani delovnega obmocja. V vrstici
urejanje so namescena pogosto rabljena orodja, tako je delovanje bolj fleksibilno in
prepricljivo.

Vrstica nastavitev: nastavitev izbranih objektov.

Nadzorna plosca: uporaba nadzorne plosc¢e za dokoncanje laserske obdelave veckratnih nalog,
nastavitev slojnih parametrov, nadzor osi, obdelovanje itd.

11.3.2 Nastavitev jezika in informacije o stroju

Poleg nastavitve jezika programske opreme lahko le tega zlahka spremenite.

Klikni v menijsko vrstici na pomo¢ (ang. [Help] ), nato izberi jezik (ang. [E=/Language] ,
tako da razsiri§ menijsko vrstico in izberi potrebne vrste jezikov.

Help (H)
About REOCAM

| 18S Language

Za pridobitev podatkov od proizvajalca, tako da vam lahko nudimo boljso storitev, kliknite v
menijski vrstici na pomo¢ (ang. [Help] ), nato pana [About RDCAM] .

About [5_(|

Corp. Hame: |

Te1:|

#ddr: |

|
|
Fa.x:| |
|
|

'|'|'eb:|

0K




11. 3.3 Nastavitev strani
Klikni na [Config] -> [Page setting] (slov. nastavitev strani) in pojavilo se bo
naslednje okence:

Page setting r$_<|

Fage width (mm):
Page height (mm): 800

Page home Top left | =

cancal

[Page width] : Sirina strani programske opreme, ponavadi je misljena $irina stroja X.

[Page height] :Dolzina strani programske opreme, ponavadi je misljena Sirina stroja Y.

[Page home] :Nigelnost strani programske opreme, ponavadi je misljena privzeta pozicija
stroja.

File(F)  Edit(E) Draw(D) ConfigE) Hendle®)  Wiew(¥)  Help(H)
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T - Find Com | futo =
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-~ |2-] Layer  Mode  Speed | Power | Output
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®| : < | E
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A E FPosition: |Current positio|w
= Go scals Cut zcale
B8]
E §_— Start Pause/Continue Stop
3 SavelolFile | UFileQutput |Download
[Joutput select graphics
o [“]Path sptimize
E:
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E = 2t | Speed(unfs): E
= 1= I+ Fower (%) |0
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II. 3.4 Odpri datoteko in shrani

Programska oprema uporablja obliko zapisa rld, da shrani graficne podatke, spodnje
parametre razli¢nih slojev in obdelavo grafi¢nih elementov.

II. 3.4.1 Odpri datoteko
V menijski vrsti klikni na »datoteko« in nato na »odpri« (ang. [File] -> [Open] ), nato na
ikono. Pojavilo se bo naslenje okence:

Lok jn: | (& Desktop v O @ e E-

BMy Dacuments

j My Computer

‘HM@-‘ Metwork Places
ICIRDCAMSEtUp ¥3.0.2
IC)SendCommand

i [

File name: |Default.rld | [ Open l

Filez of kype: | *.1id v| [ Cancel ]

[ ] Open az read-only

Izberi datoteko (na primer privzeto rld), klikni »odpri« (ang. [Open] )



Il. 3.4.2.Shrani datoteko

(1) V menijski vrstici klikni na »datoteko« in jo nato shrani, torej
> [Save] . Klikni na ikono B in pojavilo se bo naslednje okence.

Look jn: | @ Desklop

' My Computer

BMy Documents Defaulk, rld

%y Metwork Places
ICIRDCAMSEtUp ¥3.0.2

Input file name

I3 SendCommand

[ tktt

File name: | Defaultrid

e |

Filez of type: | *1id

v| [ Cancel ]

[]0pen as read-only

Vnesi ime datoteke v okence za urejanje in klikni »shrani« (ang. [Save] ).

II. 3.5 Uvazanje in izvazanje datoteke
Obilka zapisa datoteke za uvazanje: dxf, ai, plt, dst, dsb... itd.
Obilka zapisa datoteke za izvazanje: plt

III. 3.5.1 Uvazanje datoteke

[File] -

Klikni na »datoteko« in nato na »uvoz« [File] -> lImport] . Zatem klikni na ikono
Izberi datoteko in klikni »odpri« oziroma [Open] .



Import

Lok jri 3 PLT v QXM
i oonon3a. plt @R ol o #45
557, R plt o &.pl
U 7000.plt EEETEF 1.0t I BT plt
g 5576t TR AL, plt o ¢ ol
@ ns0721.plt 7 plt
i P U T e
7L Airplane, plt @l‘ﬁﬁ.plt
W Alphabet ol EEEEL plt
t= AP, plt = 5, plt
E@Eeach.plt @Egﬁﬁ.plt
R Box and Curve plt I E. plt
E@on.plt @ B 1 plt
R Business. plt I 22323 plt
E@Circle.plt @ﬁ%%.plt
U COMGER. pit I B plt
@Curve.plt @:—Egﬁ?ﬁgﬁ‘é‘.plt
] deautt.rd EHE pt
@gemm.p\t @’J\—E_u.plt
i job 2.t T . i
E@shoelZ.plt @Jﬂ.‘ﬁ.plt
O 2. plt L #is Ik = pi

Ereview

File hame; Ajrplane. plt
Files of type: Supported Files1 v

Izberi [Preview], izbrana datoteka se lahko prikaze. Za vecino vektorskih datotek
se podatki glede na opis plasti samodejno uvazajo v primerni del programske
opreme RDCAM. Za posebne dokumente, kot sta DST/DSB, se bodo podatki vnasali
v trenutno podlago.

Laak jn: =3 DST 3 0 ¥ o EI'
[=]arudie1.0sT

L5045-,D5T
L5066.D5T
Lx215.05T
MIS0.DST
PORSCHEZ.DST
SUNFLOWR.DST
YERONIKA. DST

Freview
Fiename.  [Ahudiel.DST

Trenutna
podlaga

l‘ HE NN = H




II. 3.5.2 IzvaZzanje datoteke

V menijski vrstici klikni na datoteko, nato na izvoz in na ikono = . Odpre se okno s
podatki o izvozu. Vnesi ime datoteke in klikni na »shrani« ali »save«.

[I. Nastavitev parametrov datoteke

Natanénost [Blll: glede na natag¢nost izvorne datoteke [l izberi primerno enoto za
uvoz.

Rahle krivulje: med uvazanjem vektorske datoteke samodejno poravnaj prvotne
krivulje. Kolikor Zelite, da je originalni graf bolj raven oziroma obstaja potreba po
ponovnem uravnavaniju rahlih krivulj, lahko to funkcijo odkljukate. Rahle krivulje lahko
zmanjSajo Cas uvazanja.

Krivulje, ki se samodejno zapirajo.

Samodejni izbris ponovnih linij: samodejno odstrani povsem prekrivajoCe se krivulje.
Zdruzuj linije: glede na toleranco zdruZevanja so to samopovezujoCe se krivulje.
Natancnost pri izvozu: natan¢nost pri izvazanju datoteke plt in izdatne datoteke.
Enota za hitrost: dve vrsti enote hitrosti mm/s, m/, podprti s programsko opremo.

File Parameter EJ

Import Setting

PLT Precision: -

|:|Smu:--:-th curves
Smooth precisioen($); |20

Autu:u close curves
Cloze error (mm): (0.1

ﬁ.utl:- delete repeat lines
Cnmbine lines
Combine error (mml: [0.1

Export Setting:

Export Precizion(%): 100

Velocity Unit: |3/ B0 inf=| -

conel

Osnovno grafi€no oblikovanje

e Crta
V meniju klikni na »narii«, nato na »¢rta« (ang. [Draw] -> [Line] , ), klikni »popravi
vrstico« 4 , povleci miSko in na zaslonu lahko nariSe$ kakrsno koli poljubno ¢&rto.

Prtisni na tipko »ctrl«, medtem ko vle€es$ misko in tako nariSes poljubno Crto.



Vedkratne drte

V menijski vrstici klikni na »nariSi« in »veckratne Crta«, nato na »popravi vrstico«.
Povleci miSko na zaslonu, nariSeS lahko poljubno veckratno crto.

Pravokotnik
V menijski vrstici klikni na »nariSi« in »pravokotnik« [Draw] -> [Polyline] in klikni na

»popravi vrstico« U . Na zaslonu povleci misko in nariSi pravokotnik v poljubni
velikosti. Pritisni »ctrl«, ko vleceS misko.

Elipsa

V menijski vrstici klikni na »nariSi« in »elipso« in klikni na »popravi vrstico«
Povleci miSko na zaslonu in nariSes lahko elipso v poljubni velikosti.

Besedilo
V menijski vrstici klikni na »narisi« in »besedilo« (ang. [Draw] -> [Text] ) in klikni
A

popravi vrstico

Dve vrsti zapisa za sestavljanje besedila, podprti s programsko opremo: pravi tip in
SHX.

@TruET}TE Font: T i J:':Ij{ﬂalz L'
Osm v gymsom 81540 12

Dvakrat zaporedno klikni na zaslon in pojavilo se bo naslednje okence:

Text §|

Text height (mm): g
Text diztamce mm): |0

Line distance (mm): 0

Text

conct

Vnesi besedilo in ga nastavi, klikni tipko [OK]




Il. Izbira predmeta
Med samim procesom risanja in popravljanja grafik, se najprej mora izbrati predmet.

Ko se predmet izbere, le ta ima na sredini oblikovano oznako »x«. Obdaja jo osem
nadzornih tock.

V meniju klikni na »narii« in »izberi« (ang. [Draw] -> [Select] , ), klikni na

popravi vrstico [:3 in preklopi na stanje . V tem stanju lahko izbere$ predmet. V

nadaljevanju imamo pet vrst metod izbiranja:

eV menijski vrstici klikni na »popravi« in »izberi vse« (ang. [Edit] -> [Select All])
(bliznjica: Ctrl+A), izberi vse predmete. Klikni na miSko na zaslonu in izberi en

predmet:
| | |
¥
| o |
LY.
| | |

Izberi predmet z uporabo okenca za izbiranje.

Klikni na miSko in jo vleci vse dokler je okence z njo v stiku in predmet je izbran.
Povecaj izbiro predmeta, pomanjsaj izbiro predmeta.

Povecaj izbiro: pritisni »shift« in klikni »izberi« (ang. select), da poveca$ izbiro
predmeta.

Pomanjsaj izbiro: pritisni »shift«, klikni in okence izbere predmet.

Izberi predmet glede na podlago.

Layer Farameter

Layer Made  Speed Power Output

Cat  100.000 30,000 Tes
Cat  100.000 30,000 Tes
Cat 100,000 30,000 Tes
Cat  100.000 30,000 Tes
Cat  100.000 30,000 Tes

g Dawn

Z desno stranjo miSke klikni na izbrano podlago, potem na vse dele predmetov in
izbrana je podlaga.

Il. 3.8 Barva predmeta
Barva predmeta je barva konture predmeta. Kliknete lahko na barvo v vrstici za

podlago, da spremenite barvo izbranega predmeta. Tipka, ki pritisnete, ima barvo
trenutne podlage.



II. 3.9 Preoblikovanje predmeta

Preoblikovanje predmeta v glavnem vkljucuje: lokacijo predmeta, orientacijo in velikost,
vendar ne spremeni osnovno obliko predmeta in njegove karakteristike.

II. 3.9.1 Slika predmeta

Zavrti izbran predmet v vodoravni ali navpi¢ni smeri. Klini na popravi vrstico A

in zavrti

=l .. .y
izbran predmet v vodoravni smeri ™ . Zavrti izbran predmet navpicno.

I1. 3.9.2 Vrtenje predmeta

Klikni popravi vrstico O in pojavilo se bo okence o nastavitvi vrtljivega kota. Klikni na
[OK].

Eotate [$_<|

FEotate angle (deg)
Cac

Ce zelite povecati vrtljivost, nastavi vrtljiv kot na 0 in doloéi.

. 3.9.3 Velikost predmeta

Izberi predmete in klikni »popravi vrstico« =" in pojavi se okence o nastavitvi
velikosti.

Data Size r')_(|

LN
| om0

=




Nastavite lahko velikost in srediS¢no to€ko izbranega predmeta. S kljukico lahko

zapre$ razmerje izbranega predmeta ﬂ

I1.3.9.4 Razvri¢anje podvojevanja predmeta

Klikni na »popravi vrstico« [3 in kopiraj izbran predmet. Nato klikni na B in pojavilo
se bo naslednje okence:

Hatriz Copy

Fiers size

o [345.912 mm
T |esz.07 mm

Matrix Direction

@Top left OTop right

OBottom left OBottom right

Frame Width(mm): |1200
Frame Height (mm): 0o
X num:
¥ mum:

¥ Distance (nm):

LT

¥ Distance (nm):

D]Ji stance between center

| Bestrewing breadth

hpply

D Center

1):3 Cancel

¥ Sirina enega grafa (mm) I vigina enega grafa (mm)

Podvojane predmete lahko razvrstite v razlicne smeri. Smer kopije sloni na prvotnih

grafikah. Izberi puscice, ki so obrnjene spodaj desno. Originalna grafika se bo
pojavila zgoraj levo, €e so puscice obrnjene zgoraj levo, se originalni graf pojavi
spodaj desno. Po nastavitvi Stevila pusc€ic in nastavitve pus€ic, pritisni tipko
[Apply] .

Imamo dve obliki postavitve puscic: postavitev na sredino in na rob.
Izberi postavitev na sredino, nato klikni na razdaljo X (mm), razdaljo Y (mm), ki
predstavljata razdaljo obeh grafi¢nih centrov.

Ce ne izberemo postavitev puddic na sredino, potem klknemo na [X
Distance(mm)]) , [Y Distance(mm)], ki predstavljata razdaljo grafi¢cnega roba.

Razdalja X od sredine: razdalja od roba X + Sirina objekta
Razdalja Y od sredine: razdalja od roba Y + dolzina objekta



Izbiraj med dvema metodama izraunavanja. Razdalji X in Y bosta samodejno

izraCunani.

Klikni na [Bestrewing breadth] . Programska oprema bo samodejno
Stevilko puscice glede na velikost, Sirino, razdaljo X in Y.

Nastavitev je lahko neposredno vnos, nato klikni »uporabi« [Apply] .
Pritisnes$ lahko tudi smerokazne tipke, da nastavis$ predmete.

Preglej sredis¢e (ang.

izracunala

[Center] ) in podvajanje puséic, grafike bodo osredotoene

na delovno podrocje. Povleci kolo na misSki, da pomanjsas grafike. Povleci misko,

tako da bos videl grafike.

Natrizx Copy

Piece size

i 345,912 mm
T |eszoo7 mm
Matriz Direction
, @Top laft OTop right
% OBottom left OBottom right
Q D Frame #idth(un): 1200
Frame Height (mm): aao
¥ orum: |3
7 ¥ num: |3
¥ Diztanesimm): [0
¥ Distance(um): [0
I:‘]Jistance between center
EBestrewing breadth
Apply
I:‘Center
Ok Cancel
II. 3.9.5 Postavi predmet v prvotno stanje
Klikni na , izberi predmete, ki se morajo postaviti v prvotno stanje in nato klikni .
I1.3.10 Namestitev predmeta
Izberi predmete, klikni na orodja v vrstici za nastavitev

A £

{D}EDQ Df} I

2 & 0 oo

postavitev levo, postavitev desno, postavitev na vrhu, postavitev na dnu

mfh LA
Ly =

HEZBWUE 1 yjueeo:

mn
Vertikalna, horizontalna postavitev, postavitev v srediScu.

H 5 Horizontalna enako dolga razdalja, vertikalna enako dolga razdalja




= [0 B Enaka Sirina, enaka dolzina, enaka velikost

Merilni objekt:
Ce pritisnes tipko »shift«, izbiraj predmet en za drugim. Potem je merilni predmet
zadnji. Ce izberes predmet, je merilni predmet predmet.

11.3.11 Pogled na predmet
Pomakni: v menijski vrstici klikni na »uredi« in nato »pomakni« (ang. [Edit] ->

+
[Move] , ali klikni na . Na podrocju risanja pritisni na levo tipko miske in povleci
svincnik.

Povecaj: v meniju najprej klikni na »uredi«, potem pa na »poveéaj« (ang. [Edit] in -

> [ZoomOut] , klikni na .. Z vsakim klikom se podroCje risanja poveCa za enkrat.
Povleci miSko na podrodje risanja in klikni. Z vsakim klikom in z miSko na sredini
podrocja risanja se to podrocje poveca za enkrat.

Pomanj$aj: v meniju najprej klikni »uredi«, nato »pomanj$aj« (ang. [Edit] -

> [ZoomlIn], ali klikni na . Z vsakim klikom pomsanj$aj podrocje risanja za
enkrat. Povleci miSko na podro€je risanja in klikni. Z vsakim klikom in miSko na
sredini podroc€ja risanja se le to pomanjSa za enkrat.

Poglej/izberi: v meniju klikni na »uredi«, nato pa na »poglej in izberi« ali klikni na =
Povleci miSko na podrocje risanja, pritisni na levo tipko miske in vleci. Na podrocju
risanja se bo pojavilo okence.

Pogled okvira strani: v menijski vrstici klikni na »uredi« in na »pogled okvira strani«

(ang. [Edit] -> [View Page Frame] ) ali klikni na B. . Okvir strani se bo prikazal v
celoti.

Pogled podatkov: v menijski vrstici klikni na »uredi« in »pogled podatkov« [Edit] -

> [View Data Frame] ali klikni na . Izbrani predmeti se bodo prikazali v celoti.

I1.3.12 Pomembno orodje
Tukaj so najpogosteje uporabljena orodja. Uporaba teh pomembnih orodij lahko preuredi
trenutni dokument v grafikah in s tem je tudi obdelava rezultatov hitrejsa.

II. Ro¢no nastavi vrstni red izrezovanja

Uporabniki lahko rocno nastavijo Stevilko izrezovanja vsakega predmeta. V menijski
vrstici klikni »uredi« in nato »prikazi smer« (ang. [Edit] -> [Show direction] ). Prav
tako klilni na »uredi« in »prikazi pot« (ang. [Edit] -> [Show path] ). V sistemski

L + L1 .. . . . .
vrstici klikni na . . Delovno podro€je bo prikazalo pot in smer izrezovanja.

Crtkaste &rte pomenijo, da je laser izklopljen.

—
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——— #Welcome to use the Laser system of cutting Fropose the display area 10244765 or higher ®-——

Obdelava grafikov poteka po Crtkastih ¢rtah.

Vrstica za izrezovanje pokaZze serijsko Stevilko izrezovanja trenutnega izbranega
predmeta. V kolikor spremenite serijsko Stevilko, se bo spremenilo tudi
zaporedje/vrstni red izrezovanja.

[I. Ro&no nastavi smer izrezovanja in zaCetno tocko/izhodis¢e
V menijski vrstici klikni na »uredi« in na »prikazi smer« (ang. [Edit] -> [Show

Direction] , v sistemski vrstici klikni na naslednjo ikono . Ta prikazuje smer
izrezovanja.
V meniju klikni na »uredi« in na »prikazi tocko« (ang. [Edit] -> [Show Point] , ). V

sistemski vrstici klikni na ikono * , ki prikazuje vse to¢ke izbranih grafik.

V meniju klikni na »uredi« in na »nastavi tocko izrezovanja« (ang. [Edit] -> [Set Cut

Point] ) oziroma v sistemski vrstici klikni na @u_ Pritisni na »uredi tocCko
izrezovanja«. Kot prikazujejo naslednji podatki je vozel, ki ga obdaja puscica, toCka
izrezovanja. Dvakrat klikni na vsako toCko krivulje in toCka izrezovanja se namesti na
tocko.



V meniju klikni na »uredi« in »nastavi smer izrezovanja« [Edit] -> [Set Cut

B

Direction] oziroma v sistemski vrstici na ikono
izrezovanja.

Dvakrat kliknite na vozel, ki ga obdaja pusCica in smer izrezovanja predmeta bo
obratna.

, S Cimer boste urejali smer

=]
e
File (F) Edit (E) Traw (D) Config(S) Handle () View (V) Help (H)
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[I. 3.12.3 nastavljanje in urejanje vrezovalnih in izrezovalnih Crt
Risanje ali izvaZanje krivulj. Krivulja je privzeta, ¢e nima vrezovalnih ali izrezovalnih
¢rt. Ce zelite dodati vrezovalne in izrezovalne Crte, izberi predmete, nato klikni

»uredi« in zatem »uredi vrezovanje« oziroma klikni na ikono @ . Pojavi se naslednje
okence.



Cut in and out setting

Cut in
Ena]:-le
Line type: |Line b
Length (mml: |2
With angle -
Angle (degrea): o
Cut out
Ena]:-le
LineType: w hil
Length (mml: |2
lC‘:*:'Fernsule
INale

canct

Da naredimo vrezovalne in izrezovalne ¢rte, moramo najprej omogociti funkcijo
vrezovanja in izrezovanja. Imamo dve vrsti vrezovalnih in izrezovalnih Crt: ravna Crta
in lok.

Ravno ¢&rto naredimo na tri nacine:
a) vrezovanje s kotom: vrezovanje, pri Cemer vstavimo izhodiséni segment v
dolocen kot, kot v nasprotni smeri urinega kazalca je pozitiven.
b) Vrezovanje na sredini: izhodi§€na tocka vrezovanja je sredina.
c) Vrezovanje iz sredine: smer vrezovanja poteka iz sredine proti izhodis¢ni tocki,
dolZina je kot nastavitev.

Izrezovalna

v

o - -

Vrezovalna X




Dolzina izreza v loku je kot nastavljena. Obstajata dve vrsti vrezovanja in izrezovanja
v loku, kakor kazeta nasledniji sliki:

Zenska MogKki
Nastavitev izrezovalnih ¢rt je enaka nastavitvi vrezovalnih ¢rt.

[1.3.12.4 Optimizacija poti
Optimizacija poti e primarno ponovno nastavimo vektorske grafike.

o
V meniju klikni na »ro€aj« in na »optimiraj izrez« oziroma klikni na #*° in prikazalo se
bo naslednje okence:

Cutting optimize handle §|

In=ide to ountszide

Single inmer to outer -
Dﬁ.rra}'
Height: (S0 Dir: |Up to bo|w

carcl

V meniju klikni na »uredi« in »pokazi pot« (ang. [Edit] -> [Show Path ) oziroma

klikni na |IH_I|. Pot izrezovanja lahko vidite pred in za obdelavo.



Pot izrezovanja grafikov se vedno zacne pri laserski glavi.

[1.3.12.5 Glajenje krivulj
Da krivulje ne bi bile tako ostre, lahko na podlagi te funkcije gladimo krivulje in s tem

tudi obdelavo.
V meniju kliknite na »ro€ico kontrolnika« in na »glajenje krivulje« ali kliknite na ~
Pojavilo se bo naslednje okence.

Curves smooth E'

FullFrame Cancel

[ .

Smoothness




Vlecite drsnik za glajenje in kliknite na gumb »uporabi« (ang. [Apply]) ) pred in za
prikazom krivulj v okencu. Crne krivulje predstavljajo prvotne krivulje in rdecCe
predstavljajo gladke krivulje.

Curves smooth &l
Smoothness J 30% Apply
FullFrame Canecel

Grafike si lahko ogledate, tako da vileCete miSko. PomanjSate oziroma povecate jih
lahko s kolesom miske. Kliknite na gumb »celotni okvir« in v okencu se bodo pojavile
grafike.

Po uspednem udinku glajenja kliknite na »uporabi« (ang. [Apply] ) in krivulje se bodo
glede na nastavitve glajenja gladile.

11.3.12.6 Preglej zapiranje krivulje
V' meniju klikni na »rocico kontrolnika« in »samodejno zapri krivuljo« (ang.

[Handle] -> [Curve auto close], ) oziroma v sistemski vrstici klikni na [Tin
pojavilo se bo naslednje okence.

Setting close error b—<|

Close error [mm):

Force to close

cencat




Odpravi napako. Ce je razdalja od izhodi$&ne tocke do konéne tocke manjsa,
samodejno zapri krivuljo.

Setting close error §|

Close error (mm):

Force to close

conct

Sila, Ki je preblizu: obvezno zapri vse izbrane krivulje.

[1.3.12.7 Odpravi prekrivanje
V meniju klikni na »ro€ico kontrolnika« in »zbriSi preskok« oziroma klikni na

= . Programska oprema bo samodejno odstranila krivulje, ki se pokrivajo, znotraj
izbranih krivulj. Obstajata dva dela funkcije, da odpravimo prekrivanje. Razbij krivuljo
na Stevilne dele, da krivulja pokriva sama sebe.

Samodejno preveri krivulje, ki se povsem pokrivajo in jih poskusi opraviti.

Check ovelapping lines

Cwvelapping lines exisk, delete ar nak!

[1.3.12.8 Kombiniraj krivuljo
V meniju klikni na »rocCico kontrolnika« in na »kombiniraj krivuljo« oziroma klikni na

=t Pojavilo se bo naslednje okence:

S5etting combine error §|

Combine error (mm):

conct

Programska oprema samodejno zdruzuje krivulje v izbrane krivulje. Ko te krivulje
zdruzujejo toleranco, je to manj kot nastavitev kombinirane napake.



11.3.12.9 Bitna rodica

Klikni na k , izberi bitno mapo in v meniju klikni na »kontrolnik roCice« in nato na

»bitno rogico« (ang. [Handle] -> [Bitmap handle] ) ali pa klikni ™™ v sistemski
rocCici.

Baitmap handle |z|

Fizels 1536 Fizels

Pixels 2048 Pixels
Pixels/inch 39 Fixels/inch
Pixels/inch 29 Fixels/inch
Brightnes: i

L J ._Zero

0.0%
Contrast:

0. 0%

D Invert coler

Resolution (pixels/inch)

Resolution (pixels/inch]
[0 ther

Het graphic

Frequency (lines/inch]: |:|
Dot graphic
T Black And Yhite
2 Gray scale
e - | Apply to wiew || Apply to source |

i Save az i!ffullScreen! Ok || Cancel |
[ 1

Zgoraj desno se pojavi okence s podatki o trenutni sliki. Bodite obveSCeni o tem, da

se horizontalna in vertikalna locljiviost spreminjata z lestvico.

Uporabi in preglej (ang. [Apply to view] ) :trenutne nastavitve se uporabljalo le za

predogled, brez tega, da bi vplivali na originalno bitho mapo. Pritisni na gumb
[cancel] ali »prekini« in bitna mapa se bo povrnila v stanje prvotne slike.

Uporabljaj ga samo za to, da prilagodis uCinek. Ta pristop zahteva veC Casa in tudi
spominskega prostora.

Uporabi, da odkrijes [Apply to source] : trenutne nastavitve se uporabljajo samo za
prvotno bitno mapo, tako da v vsakem primeru kliknite na gumb.

Prekli¢i [Cancel) in slika se ne bo mogla vrniti v prvotno stanje. Zato v glavnem gre
za postopek z ve€ koraki. Ta korak je treba izvesti. ObiCajne slike se morajo pretvoriti
v sivino.To nam prihrani €as pri delu z raCunalnikom, zlasti pri sledeCem postopku.
Shrani kot ali ang. [Save as] :Pridobi rezultate prej$njega postopka. Poleg funkcije
»uporabi in poglej« obstaja tudi funkcija izvazanja. S tem lahko olajSate sledeco
obdelavo.

»Sivina« obdelava drugih slik ponavadi temelji na sivini. Preden kakor koli ravnate
lahko obdelate slike v sivini in kliknete gumb [Apply to source] . Obdelava drugih
slik temelji na sivini. Preden ravnate, jih lahko obdelate v sivini, nato klikni na [Apply
to source] . Za sivino v primerjavi z barvno sliko upurabljajte malo spomina, za veéje
slike ravnajte korak za korakom. Do doloCene mere se izogibajte pomanjkanju
spomina.



Za barvno sliko uravnavajte kontrast in svetlobo, pomagajte si s tresljaji.

Uravnavajte kontrast

i oranacm

Po obdelavi
Pred obdelavo

Preobrazba:

Imamo tri metode za tresljaje: grafika net, grafika dot, ¢rno in belo.

1 Mrezna Grafika
Za mrezno grafiko moramo uravnavati velikost mreze, to pa bolje ustreza materialu,

ki nima velike lo€ljivosti ali pa je laser relativno prepo€asen, da se odzove. Da boste
dobili Zeleno mrezno velikost, lahko uravnavate lo€ljivost in mrezno frekvenco slike.
Cim visja je logljivost, tem vegja je obg&utljivost. Z vegjo mrezno frekvenco se manj$a
velikost mreze. Manj$a je mrezna frekvenca, vecja je velikost mreze. Obi¢ajno je
lo€ljivost slike 1000 in mrezna frekvenca ima od 30 do 40 ¢rt.
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2 PikCasta grafika

Pik&asta grafika v dobri sivini bolje ustreza materialu z vecjo locljivostjo in laser se
hitreje odziva.

3 Crno in belo
V vecini primerov so ucinki pretvorbe barvne slike v ¢rno in belo sliko slabi, za sliko z
jasnim zarisom so enostavni za uporabo.

Y R



Il 4. poglavje Sistemske nastavitve
Pred rezultati grafik je potrebno doloditi, ali so nastavitve sistema pravilne. V meniju

klikni na »konfiguriraj«, nato na »nastavitve sistema« ali (ang. [Config] —> [System
Setting] ).

Config(@)| Handle®) Vie

| Swstam Satting |

File Para Setting

Fage Setting
Pazsword Setting

Graph Hatch

II. 4.1 1zvoz laserja

Laser export |General settings | Machine para | Document | System Info

Srarming (Rewerse interwal)

Feeding Count: Spead (mmi =) Reverse ...
Tistance (mm):
Omo‘gogl Frolumn setup
hranjenje X Hum: 1 Y Fum: [1
¥ezpace (mm): [0 Yepace (mm): |0

|:| Enable center distance

Bestrewing breadth. ..

< >
DEnable rotate engrave
_ Add. .. Del
Diameter (mm):
Step per rotate (pulsel: — (O I 0

Nastavitev hranjenja

Za polnjenje morate najprej omogociti polnitev. Potem ko so polnitveni parametri
nastavljeni, bo jasSek polnil polnitveno dolzino. Ponovite ta proces, dokler Cas
obravnave ne doseze Stevilo polnitve.

Nastavitev puscic

Nastavitev puscic poenostavlja in olajSa obravnavo puscic v grafikah.

Stevilkka X in Y ustrezata vrsticam in stolpcem puséic. Mesto x in y ustrezata
names&enju pusddic v vrstice in stolpce. Ce ni odkljukano, omogo¢i »razdaljo od
sredine«, namesCanje x in y pomenita namescanje po robu, drugace pa to pomeni
namescanje na sredini.



Nastavitev Sirine:

Glede na velikost okvira in trenutne nastavitve puscic dolo€imo najvecje mozno
Stevilo stolpcev (Stevilo x) in vrstic (Stevilo y).

Pritisnite na gumb nastavitev Sirine (ang. bestrewing breadth) in pojavilo se bo
naslednje okence.

Bestrewing breadth §|

X breadth (on):

Y braddthmm): (500

cancl

Klikni OK in programska oprema bo samodejno izracunala ustrezno Stevilo vrtsic in
stolpcev.

Zasuk vrezovanja

Omogocdi zasuk vrezovanja

Omogodi zasuk vrezovanja [Enable rotate engrave] :Potem ko smo omogodili
vrezovanje, je dejanska natancnost osi y odvisna od premera in koraka glede na
zasuk, da ta samodejno ustreza nastavitvi natancnosti pulza osi y. Poleg tega se bo
delovno podrocje v glavhem vmesniku tudi spremenilo.

Premer [Diameter] :velikost premera delov
Korak na zasuk [Step per rotate] : Stevilo pulza ustreza enkratnemu zasuku dela

Obrni interval

Medtem ko je skaniranje dvosmerno, lahko napetost pasu povzroCi rob grafiCne
nepravilnosti. Da to spremenis, nastavi mrtvi tek. DoloCena hitrost ustreza
specificnemu mrtvemu teku. Cim vecja je hitrost, tem vedji je mrtvi tek.

Dodaj nastavitev mrtvega teka
Klikni na gumb »dodaj« Add in pojavilo se bo naslednje okence.

X]

Speedimmi=)
b

Rewerse interwal (mm)

cunct

Po nastavitvi hitrosti in obraanju intervala klikni na OK in vrednost mrtvega teka se
vnese v seznam mrtvega teka.




Spremeni nastavitev mrtvega teka
Dvakrat klikni na toCko v seznamu mrtvega teka in pojavilo se bo naslednje okence.

X

Speed(mm#s) | AL

Rewerze interwal (mm)
Cac

Odpravi nastavitev mrtvega teka
Klikni, da izberes tocko, ki jo zZeli$ izbrisati in klikni na »izbriSi« ali »delete«.

[I. SploSna nastavitev

Settaing

Lazer export | Feneral settings |Mar_'hine para | Dacument || Sy=tem Infa

berizs Mirrer Lazer head

o O o Joint Precision (0-2mm): ICI

o O O Fun R -3 -
[#]hxiz T Mirror OO0 un Repay (0-3mm): []

Cutting space Repay

Small eirele =peed limit DEnable cut bacldlash repay
Radiuz (mm) Speedimmi =) i g
Repay: o o
Space (mm): (0 0

DCutting lazer on—off repay
LaserOn  LaserOff

< | > Repay (mm) | || |

add Delete Ener gy (%] I:l

Zrcalo osi

Obicajno je smer osi zrcala odvisna od dejanske lokacije meje ali privzetosti stroja.
Privzeti sistem koordinat, &e Descartes koordinira sistem in ni¢la spodaj levo. Ce je
ni¢la stroja zgoraj levo, potem os x ne odbija, os y pa mora odbijati.

Ce je ni¢la stroja zgoraj desno, potem obe osi, tako x kot y, morata odbijati. Poleg
tega se ta funkcija lahko uporabi za drug aplikacijo za zrcalo.



Glava laserja
Polozaj glave laserja pomeni, da je lokacija laserske glave sorazmerna z grafiko.

|
%9 éEb %i?
ole Q0 a0

Zgoraj levo Zgoraj na sredini  Zgoraj desno

{Eij (Eiﬂ (7,
o o0 B o 0

|

Na sredini levo V srediS¢u Na sredini desno

95 W2 i

e 1%, a0
| Spodaj desno

Spodaj levo Spodaj na sredini

Skupna to€nost (od 0 do 2 mm)

Ko meri razdalja med kon¢no to¢ko ene Crte in koncno Crto druge Crte manj kot
skupna to€nost, potem programska oprema samodejno poveze ti dve Crti.

Opozorilo: ta vrednost se ponavadi nastavi 0,1 mm za velike koli€ine graficnih
podatkov, da se zmanjSa Cakalni ¢as pred obdelavo na 0 mm.



ZazZeni repay .
Da bi skok bil hitrejsi, lahko pride do napake. Ce zaZenemo repay, lahko to
nadomestimo.

Majhen krog omejitev hitrosti
Pri obdelavi dela doloCi programska oprema samodejno, ali trenutni krog mora omejiti
hitrost. Nato se glede na velikost premera kroga dolo¢i hitrost.

Ce je konfiguracija parametrov ustrezna, bo to zelo poveé&alo kakovost majhnega
kroga. Klikni na »dodaj« in »zbriSi« ter konfiguriraj.

Programska oprema bo samodejno izraCunala hitrost kroga glede na seznam
omejitve hitrosti kroga.

Rezalni laser on-off repay
Potem ko omogocimo funkcijo »cutting laser on-off repay«, programska oprema
glede na nastavitve on-off repay samodejno reze.

Repay: vklopljen laser, kako se laserska energija postopa spreminja iz zaCetne do
normalne energije, medtem ko se stroj od zaCetne toCke pomakne za repay dolZino.
Izklopljen laser, stroj se od konéne toCke pomakne za repay dolzino.

Energija (ang. [Energy] ): energija zacetne tocke grafikov.

[1.4.3 Strojni parametri

Setting

Lazer export | General settings | Machine para |Document | System Info

B Cut parameters A | [ Axiz parameters ”
Idle speed(mmf=)  200.000 hxisz X
Idle Acclimmf=2) 3000, Q0o Direction polarity Hegatiwe
Start speedimm/s) 20,000 Limiter polarity  Hegatiwve
Min Ace (umd=2) 400. 000 Contrl Mode Fulzsetlir
Max boc (mmd=2) 3000. 0o Kewving direction  Hegatiwe
Cutting mode Hormal Cutt Step lengthfum) 0.350
hee Mode 2 mode Max speed (mms) 1000. Q0o

[o] Sweep parameters Jump—off =zpeedimm/ 5. 000
x¥ Start Speedimm/s 10.000 froceleration (umfs2 S000. 000
¥ Start Speed(mm/s 10.000 w Breadth (nm) 1000, foo v

Open Read

Sledi opis parametrov stroja:
A. laserski parametri
a) Laserski nacin: imamo tri vrste laserskih naprav: domaca steklena cev, RF
laser (prezgoden pulz ni pogoj) in RF laser (prezgoden pulz je pogoj), steklene
cevi sprejmejo analogno koli€ino za nadzor, RF cevi sprejmejo digitalno



koligino za nadzor. Ce stroj sprejme domaco stekleno cev, je vrsta laserja
»analogna koliina«, Ce pa sprejme RF cev, se razmerje izbere temu primerno
(prezgoden pulz je pogoj//ni pogoj). Po spreminjanju opcij vrst laserja, naj bi se
sistem ponovno zagnal in spremembe naj bi bile po ponovnem zagonu
ucinkovite.

b) Laserska frekvenca: frekvenca pulza nadzronega singnala, ki jo uporablja
laser, namescen na stroju.

c) Maksimalna mo¢ (%), minimalna moc€ (%): za laser lahko nastavi§ omejitvene
vrednosti moci, in sicer med delovanjem, maksimalna mo¢, ki jo nastavi
uporabnik ne sme biti viSja od maksimalne moci, ki je nastavljena tukaj, in
minimalna mo¢, ki jo nastavi uporabnik, ne sme biti niZja od minimalne mo¢i, Ki
je nastavljena tukaj.

d) Zastoj ob vklopljenem oziroma izkloplienem stroju: ¢e zastojni parameter ob
vklopu in izklopu ne kaze 0, se laser vklopi Ze vnaprej in se izklopi po zastoju,
ki je bil nastavljena vnaprej. Casovna zamuda zna$a od 0 do 0.1 sekund.

Drugi parametri

Ponovno nastavi hitrost: ta parameter sluzi vrnitvi hitrosti stroja v prvotno stanje, ko
se le ta zazene. Ce je stroj presirok, lahko nastavi§ primerljivo vrednost ponovne
nastavitve hitrosti. Hitrost ne sme biti nastavljena previsoko, kontrolnik nadzoruje ta
parameter znotraj 50 mm/s. Vsakrdna ponovna nastavitev hitrosti s strani uporabnika,
ki presega 50 mm/s, naj se smatra kot neveljavna.

Hitrost ob mirovanju

Ta parameter dolo€a maksimalno hitrost vseh Crt, ki ne oddajajo zarkov med
delovanjem stroja. Ta parameter naj ne bi bil nizji od odsko€ne hitrosti osi x in osi y.
Parameter ne sme presegati maksimalno hitrost osi x in osi y, e je nastavitev
nedovoljena, kontrolnik samodejno nastavi parameter znoraj zgoraj omenjene
omejitve. Primerljivo visoka hitrost ob mirovanju lahko skrajSa ¢as delovanja.
Prekomerna visoka hitrost mirovanja lahko povzro€i tresanje poti, zato morate ob
nastavitvi upostevati vse ustrezne faktorje.

Hitrost Citanja s premikom Crte

Ta parameter se posebej uporablja za nadzor maksimalne hitrosti Citanja z
vertikalnim premikom z ene &érte na drugo. Ce je med &itanjem veliko prostora med
vrsticami oziroma je prostor oviranja velik, lahko nastavite hitrost Citanja s premikom
med vrsticami na primerljivo nizjo vrednost. Ta parameter ne sme biti manj kot
odskoCna hitrost ustrezne osi med premikom med vrsticami in ne sme biti viSja od
maksimalne hitrosti ustrezne osi med premikom med vrsticami. Ce je nastavitev
nedovoljena, bo kontrolnik samodejno nastavil ta parameter znotraj zgoraj omenjene
omejitve.

Pospesitev:

Ta parameter doloa pospeSitev in zaviranje (stanje S ali stanje T) motorja med
delovanjem. Motor pospesuje ali zavira po¢asneje in rahlo v stanju S, medtem ko v
stanju T je to sorazmerno hitro in ostro. Privzeto stanje je stanje S.

Citanje: Na izbiro sta dva nagina: obi¢ajni nadin in posebni nagin. V obiajnem nacinu
ni delovanja med Citanjem. V posebnem nacinu gre za delovanje svetlobnih mest. Ce
se aktivira posebni nacin, se pove€a mocC laserja in s tem se tudi zniza odstotek



svetlobnih mest in mo€ laserja. Da dosezemo isti u€inek Citanja, mora biti laserska
mocC viSja. Namen posebnega nacina je da laser oddaja zarke zelo moc¢no in v
kratkem Gasu med &itanjem. DoseZemo lahko uginek ravnina/dno. Ce pa svetlobna
mesta niso pravilno uravnavana, ne moremo doseci tega ucinka. Nacin delovanja ob
vecCji mo€i in v kratkem €asovnem razmiku lahko vpliva na vzdrZevanje laserja.
Privzeti nacCin je obicajni nacin.

Facula velikost: ta parameter je neveljaven v obi¢ajnem nacinu Citanja. Ta parameter
velja samo za posebni nacin. Verjetnost nadziranja parametra s strani kontrolnika je
od 50% do 99%.

Nacin razporeditve (pus€ic): izbira§ lahko med nihalnim nacinom in enosmernim
nac¢inom. Pri nihalnem nacdinu rezemo puscico po vrsti naprej in nazaj. Pri
enosmernem nadinu rezemo pusgico z ene smeri na drugo. Ce izberemo enosmerni
nacin imajo vse puscice isti nacin gibanja in tekoce gibe. Kljub temu bo ta nacin terjal
veC Casa od nihalnega nacina. Privzeti nacCin je nacin nihanja.

Mesto vrnitve: izberete lahko lokacijo in izvor stroja. Ta parameter doloCa mesto,
lokacijo ali izvor stroja, kjer se glava laserja ustavi po vsakem delovanju.

Zascita

Ce ima stroj dodatne za3gitne signale poleg za3gite vode, v tej opciji lahko izbirate.
Vnos za$Citnega signala se je opravil iz univerzalnega mesta 2 (prosim, glej v
navodila za uporabo za glavni raCunalnik). Ko omogo€imo ta zaScitni signal,
kontrolnik izvede preglded zascCitnega signala v realnem Casu, ¢e je vnos na visokem
nivoju, je stroj zasc€iten in delovanje se prekine, laser pa se izklopi.

Parametri osi

Ce se os x in y pomikata proti izvoru stroja, ko se elektriéni sistem stroja ponovno
zazene, to pomeni, da je polarnost smernega signala osi nepravilna. V tem Casu
lahko odklopite os od motornega zagona (drugace je pregled glavnega ra¢unalnika
nezadosten, to lahko povzroci kolizijo osi). Potem ko D16 na glavnem racunalniku
utripa (kar pomeni, da je racunalnik bil ponovno zagnan, D16 izide prvi, vsaki¢ ko
ponovno zazenemo stroj in zaCne utripati po zagonu. Ne berite in ne piSite vseh
parametrov na raCunalniku, preden D 16 za¢ne utripati; prosim, glej v navodila za
uporabo za racunalnik za mesto D16. Spremeni polarnost smernega signala osi na
racunalniku in potem ponovno zazeni raCunalnik.

Omejevalnik polarnosti: Ko os gibanja doseze mejo, se sprozi signal na nizki ravni in
vklopi svetlobno diodo, ki ustreza razliénim mejam. Ce se os gibanja odmika od meje,
se sprozi signal na visoki ravni in izklopijo se svetlobne diode, ki ustrezajo razli¢nim
mejam, mejna polarnost je negativna. Drugace je, ¢e se os gibanja odmika od meje.
Takrat so svetlobne diode, ki ustrezajo razli€nim mejam, zunaj in ko os gibanja
doseze to mejo, so svetlobne diode, ki ustrezajo razlicnim mejam, vklopljene. Mejna
polarnost je pozitivha. Nepravilna nastavitev mejne polarnosti lahko povzrocCi
nezadosten pregled sistema med ponovnim zagonom, kar lahko vodi do kolizije osi.

Kontrolni nacin: na voljo sta dva nacina: nacin dvojnega pulza in pulz + smerni nacin,
ki naj bosta odstranjena glede na vrsto motornega zagona, ki je names¢en na stroju,



obi¢ajno se izbere nacin pulz + smer. Po kakrsni koli spremembi opcije nacina
kontrola, naj bi se racunalnik ponovno zagnal in sprememba bi bila ucinkovita.

Tipkovna smer: po pravilni nastavitvi smerne polarnosti stroja se os X pomakne
desno, ko pritisnete na levi gumb. Ko pritisnete na desni gumb, se os X pomakne
levo. To pomeni, da so tipkovne nastavitve smeri nepravilne in spremembe naj bi se
temu ustrezno uvedle. Tipki gor in dol ustrezata gibanju osi y. Ce se os y pomakne
navzgor, ko pritisne$ gumb »navzdol« in se os y pomakne navzdol, ko pritisnes tipko
gor, bi se morale tipkovne smeri osi y spremeniti.

Dolzina v koraku: ali pulzna ekvivalenta motorja, to pomeni absolutno distanco, ki jo
pokriva ustrezna os, ko pulz potuje motorju. Pred pravilno nastavitvijo vrednosti,
lahko stroj pripravite do tega, da izreZze veliki pravokotnik (vecCja je slika, manj je
napak) in dolzino motorja lahko izraCunamo samodejno z dolzino slike in izmerjeno
dolZino.

Maksimalna hitrost: gonilna sila motorja in inercija osi gibanja doloa maksimalno
hitrost polarnosti osi. Med Citanjem naj Citalna hitrost ne bi prekoracila maksimalno
hitrost, ki ustreza osi Citanja. V nacCinu rezanja posledi¢na hitrost med rezanjem ne
sme prekoraditi najnizjo maksimalno hitrost osi X in osi Y. Ce je hitrost nastavljena
previsoko, kontrolnik samodejno varuje maksimalno hitrost.

Odskog&na hitrost: hitrost osi gibanja se zaéne Ze v statinem stanju. Ce je
nastavljena previsoko, lahko motor izgubi so€asnost, se zaCne tresti ali pa zvizgati.
Ce je prenizka, se hitrost delovanja celotne figure zmanj$a. Glede na inercijo osi
gibanja, lahko to vrednost nastavimo na 8 do 15 mm/s. Ce je inercija osi gibanja
previsoka (oziroma je os pretezka), lahko nastavi§ niZjo odskoéno hitrost. Ce pa
inercija osi gibanja prenizka (os je prelahka), lahko nastavis viSjo odskocno hitrost.

Pospesitev: pospeSitev osi gibanja, ko pospeSujemo ali zaviramo, previsoka
pospesitev bo povzrocila izgubo soCasnosti, tresenje ali Zvizganje motorja, medtem
ko zaradi prenizke pospesSitve pride do poCasnega pospeSevanja, kar bo zmanjsalo
hitrost delovanja. TipiGen obseg od 800 do 3000 mm/s? lahko nastavimo za os z
veliko inercijo. Os Y ustreza ogrodju, npr. tipicni obseg znasa od 10000 do 20000
mm/s2. Ta se lahko nastavi za os z nizko inercijo. Os X ustreza na primer lutki.

Sirina: maksimalna razdalja, ki jo lahko os gibanja pokrije, se dolo&i glede na
dejansko stanje stroja.



I1.4.4 Dokument

Setting

Laser export | Gemeral settings || Machine para| Document |Sectiem Infa

Document

Humber File Hame

Delete Delete A1l
Fead Download Process

Beri

Klikni na gumb »beri«, programska oprema bo komunicirala s kotrolnikom, beri
seznam dokumentov na kontrolniku.

Po uspesnem branju kontrolnika, se bodo prikazali datoteCni podatki na seznamu
dokumenta.

Prenesi

Klikni na »prenesi« in prikazalo se bo okence. Izberi preneseno datoteko rd in
datoteka se bo prenesla na kontrolnik. Ce je prenos uspe$en, se dokument
posodobi.

Proces

Izberi datoteko iz seznama dokumentov in klikni na gumb »proces«. Kontrolnik bo
obravnaval oznacen dokument.

Zbrisi

Izberi dokument, ki ga zeli§ izbrisati iz seznama dokumentov in klikni na gumb
»zbridi«. Kontrolnik bo zbrisal oznagen dokument. Ce je izbris uspeden, bo dokument
posodobljen.

Zbrisi vse

Samodejno odstrani vse datoteke v kontrolniku in posodobi seznam dokumentov.



Sistemske informacije

Setting

Laser export | Gemeral settings || Machine para | Document | System Infa

Total on time (hour: min:s):

Total processing time (hour minis):
Frevious processing time (hour:min:s:ms):
Total laser on time (hour:min:s):

Total processing times:

¥ Total trawal m):

T Total trawel (m):

Mainboard wersion:

Skupni €as: skupni ¢as racunalnika

Skupni €as obdelave: skupni ¢as obdelave, vkljucno s ¢asom skoka

Prej$nji 8as obdelave: Cas zadnje obdelave

Skupni laser: ¢as obdelave laserja

Skupna obdelava: Stevilo dokonc€anih obdelav, ne vkljuCujejo obdelave do konca
Skupno potovanje X: skupno potovanje motorja X

Skupno potovanje Y: skupno potovanje motorja Y

Maticna verzija: verzija sedanjega kontrolnika

[1.4.6 Nastavitev gesla
:unfig@:q Handl e (4] Vie

System Setting
File Fara Zetting

Page Setting

Pazzword Setting

Graph Hatch

Tovarna lahko uporablja funkcijo nastavitve gesla za nastavitev gesla proizvajalca ali
obCasnega gesla upravljalca.

Klikni na nastavitev gesla. Ce je povezan s kontrolnikom, se bo pojavilo naslednje
okence:



Input ¥endor Password [5_<|

Yendor Fassword: |:|

| 0K | | Cancel |

Po vnosu pravilnega gesla proizvajalca, se bo prikazalo naslednje okence:

[ Yendor Fassword l

I Period Fassword ]

Nastavitev prodajalCevega gesla

¥Yendor Password S5etting [')_<|

014 Password: —| 1. Vnesi staro aeslo

Hew Paszword:

2. Vnesi novo

Confirm

i

Modi £

—>
| 3. Potrdi novo geslo
[~

4. Spremeni geslo

Kot kazejo slike, vnesi staro in novo geslo, potrdi ga in klikni na »spremeni«.

LaserWork ['5_<|

L] E Passwiard modified success!
L




Obcasno geslo

Period Password Setting b_(

Humber of Feriods 1

Yendor Password:

Feriod Interwal:

[[]Varisble Feriod

| Cancel | [Save Fa=z=waor -:1]
fdl

ook
(R

|

|__—Y

—>

v

1. Stevilo obdobij

2. Vnos

3. Vnos obCasnega

4_._ Na_stavi obdobje

5. Shrani geslo

Po nastavitvi obdobja, oznaci kateri dan???
Klikni na »shrani geslo« in pojavilo se bo okence, da se shrani geslo.

Save as...

Save jn: | @ Deskiop

DMV Documents

:; My Computer

HMV Metwork Places
[CIROCAMSEtD ¥3.0.2
I SendCommand
Ittt

[£] debugeammand txt

File name:

Save ]

Save az lype: | * bk

Cancel ]

o [

' E Create Passward Success!
L

Po uspesni shranitvi gesla se pojavi naslednje okence:
LaserWork [$__<|




Podatki datoteke z geslom

[ password.ixt - Notepad

Prvo

File Edit Format Miew Help

Geslo 1. obdobja

Stevilo dneva 1. obdobja

Geslo za preklic

Ce se programska oprema zaklene, lahko vnese$ ustrezno geslo za trenutno
obdobje oziroma vneses geslo za preklic. Po vnosu gesla za preklic kontrolnik ne bo

veC omejeval.

Spremenljivo obdobje

Ce ze morate nastaviti spremenljiv dan za vsako obdobje, preverite spremenljivo

obdobje.

Period Password Setting [5_<|

Humber of Ferieds

Vendor Password:

Feriod Interwal:

[#]Variahle Feriad

RSS2

1

[ Cancel ] [Save FPaszword




Preverite spremenljivo obdobje in kliknite na nastavitev.

Period day setting rs_(|
Period HO Period Inte. ..
1 1
7 [
< IE2

Po uspesni nastavitvi zaprite okence in shranite geslo.



Il. 5. poglavje Obdelava

Device

. . ayer Farameter
iskanje

Layer Mode Speed Fower (utput

.

Find Com Auta L4

Nastavitve podlag

p Down

Laser work

Fozition: |Current positio| -

o scale Cut scale
Start Fanze/Continue Stop
Nadzor obdelave < SaveloiFile FileOutput  |Download

I:lEIutput zelect graphics
Path optimize

Current Fosition

Dt ]

i
T
Z

Frewious work time | [OH:OM:05:0MS

fxiz Mave
Offzet (um): |10
Nadzor osi — 2 | Speed(um/=): |50
¥- It Fower (%]: |0
T- 7- I:lMl:lVE from origin

[ ]If Light

[1.5.1 Iskalna naprava
Ce se je raCunalnik povezal samo z eno napravo, lahko preklopite na
samodejno funkcijo. Programskam oprema bo avtomati¢no iskala napravo.

Ce se je radunalnik povezal z mnogimi napravami, potem morate najprej
klikniti na [Find com] . Po iskanju prispevajo povezane naprave seznamu padcev.
Kar morate storiti, je da izberete oznaceno napravo.



Nastavitev podlog

Layer Parameter E

|

I= Output:
Speed(nmf=):
Min Power (%): |30
Maze Power (31: |30
If Blowing: Yeas

Processing Mode: Cut

Seal (0-Smm): |0

Open Delay(ms): |0

N
A\

Close Delayimsi: |0

Ok Cancel

Imamo dve opciji: da in ne. Ce izberes$ da, p

Imamo dve opciji: da in ne. Ce izberes da, pride do
izvoza zadevne podlage; Ce pa izbere$ ne, ne pride
do izvoza.

tes I
j B
100

Hitrost obdelave laserja: hitrost bo vplivala na
ucCinek obdelave: manjSa je hitrost, boljsSi je
ucinek obdelave in laZja je pot. Visja je hitrost,
slabsi je uginek obdelave. Ce je vrednost hitrosti
ni¢, pomeni, da smo uporabili privzeto hitrost
(hitrost, ki je nastavliena na ploSci stroja).
Prosim, vnesi ustrezno vrednost hitrosti.

4

Vrednost moci je lahko od 0 do 100. to pomeni
intenzivnost laserja med obdelavo. Visja je
vrednost, moénejsi je laser. Ce je pa vrednost
modi, je laser Sibkejsi. Ce je vrednost 0, to pomeni,
da se uporablja privzeta moc¢. (mo€ je names€ena
na plosc¢i stroja).

Nacin obdelave- nacin, kako obdelati zadevno
podlago; Ce izberete vektorsko podlago (barvno
podlago), imate tri opcije: Citanje z laserjem,
rezanje z laserjem in pikanje z laserjem; Kolikor
izberete bitno podlago, imate samo eno opcijo:
Citanje z laserjem.

Kako nastaviti pravilno minimalno mo¢ in maksimalno moc¢
Ce je laser premocCen med celotnim procesom, nastavi minimalno in maksimalno mo¢

nizje, drugace pa visje.

Ce je laser na nekaterih mestih preslab med procesom, nastavi maksimalno mo¢

vigje.

Ce je laser na nekaterih mestih premo&en med procesom, nastavi maksimalno mo&

vije.

Nastavitev parametrov obdelave pod drugacnimi nacini obdelave. Nacini obdelave
vkljuCujejo Citanje z laserjem, rezanje z laserjem in pikanje z laserjem. Bitna podlaga

se lahko obdela le z laserskim d&italnikom.

Nastavitev parametrov obdelave z laserskim Citalnikom
Ce izberes nacin obdelave z laserskim Citalnikom, se prikaze naslednji meni.



Layer Parameter EI Layer Parameter EI

I= Output: Yes - . I= Output: Yes -

Speed (mmi =) : 100 Speed (mmi =) : 100
Min Fower (%): |30 Min Power ($): |30
Max Fower (3): |30 Max Power (31: |30
If Blowing: Yes - If Blowing: Yes -
Processing Mode: Seoan - Processing Mode:
DHegative 1
|:|Ramp Effect
Eamp Length (mm]: Eamp Length (mm]:
Owerstriking: Un—process - Owerstriking:
Sean Mode: (X _swing - Sean Mode: (X _=wing -
Interwal (mm): [0-1 Interwal (um): |91
Offzety (nm) : U Offzet? (un): |0 Offzetd (nm) : Y Offzety (un): |7
Advace Advace
Ok Cancel Ok Cancel

Vektorska podlaga (barvna podlaga) ne podpira negativhega rezanja in
optimiziranega Citanja. Negativno rezanje: Ce ne izbereS negativnega rezanja, bodo
&rne pike, ki se pojavljajo po bitni mapi, odbijale laser. To ne velja za bele pike. Ce
izberete negativno rezanje, bodo bele pike, ki se pojavljajo na bitni mapi, odbijale
laser. To pa ne velja za ¢rne pike.

Optimizirano citanje: Ce izberete optimizirano Citanje, se bosta izboljSali nastavitev
Citalnega intervala in Citalni uCinek. DrugaCe naj bi izbrali Citalni interval, ki ga je
uporabnik nastavil za €itanje. Obi¢ajno izberemo optimizirano Citanje.

UcCinek rampe: Ce izberete u€inek rampe, so robovi skeniranih podatkov lahko videti
kot rampa. S tem doseZzemo trdni ucinek.

Minimalna mog, Ki je trenutno nastavljena, ustreza moc€i zgornje rampe, maksimalna
moC pa moci spodnje rampe. Isto vrednost nastavite lahko za maskimalno mo¢€ in
minimalno moc, ¢e ne izberete u€inka rampe.

DolZina rampe: dolzina rampe

Prepisovanje: vklju€uje Un-process, Intaglio in Rilievi

Ni obdelave: ne sprejema prepisovanja

Intaglio: ko izberete pisavo Intaglio (prosim, glejte spodnjo priponko), pisava se
prepisuje.

Pomnite: Ce izberete pisavo rilievi za prepisovanje pri izboru intaglio, bo pisava tanjSa
namesto debelejsa.

Rilievi: pri izboru pisave rilievi (prosim, glejte spodnjo priponko), se pisava prepisuje.
Pomnite: Ce izberete Intaglio za prepisovanje, bo pisava tanjS8a namesto debelejSa.
Dodatno opozorilo: kaj sta pisavi intaglio in rilievi?

Pisava intaglio: besedilo nima zunanje meje. Samo besedilo se mora precitati.
Prosim, glejte spodnje slike:

Pisava rilievi: tekst ima zunanjo mejo, skenirati se mora osnova slike.



Welcome

Nacini skeniranja: vkljuCujejo unilateralizm X, swing X, unilateralizm Y in swing Y.
Unilareralizm X: Laserska glavica skenira slike naprej in nazaj v smeri ravni, vendar
odbija laser samo proti eni smeri. Na primer odbija laserska glava laser, ko se
skenira od desne proti levi, vendar ne odbija laserja, ko se skenira od leve proti
desni.

Swing X: laserska glava oddaja laser in Cita slike v vodoravni smeri naprej in nazaj.

Unilateralizm Y: laserska glava Cita slike v navpiCni smeri naprej in nazaj, vendar
odbija laser samo v eni smeri. Na primer odbija laserska glavica laser med
skeniranjem od zgoraj navzdol, a ne odbija laserja, ko se skenira od spodaj navzgor.
Swing Y: laserska glava odbija laser in skenira slike v navpi¢ni smeri naprej in nazaj.
Pomnite: ponavadi sprejmemo nacin skeniranja swing X.

Interval: Laserska glava skenira interval med trenutno vrstico in naslednjo vrstico.
Manijsi je interval, temnejSe so skenirane slike, Ce pa je obrtano, pa so slike SibkejSe
(svetlejse).

Priporocilo: interval za Citanje se nastavi pod 0.1 mm za vektorsko podlago (barvno
podlago). Interval za Citanje se nastavi nad 0.1 mm za bitno podlago. Minimalna in
maksimalna moc¢ se morata spremeniti, da doseZzemo popoln u€inek skeniranih slik.

Nastavitev parametrov obdelave pikanja z laserjem

Pikanje z laserjem: risanje pik po slikah.

Kot prikazuje naslednja slika, izberite pikanje z laserjem kot nacCin obdelave in v
meniju se bo prikazalo naslednje:



Layer Parameter EJ

I= Output: |Tes - .

Speed immi=): 100

Cas odbijanja laserja na eni
piki med obdelavo. Vedja je
vrednost, temnejSa je pika.

Min Fower (%) : 30

Max Fower (%) : i

If Blowing: |Tes - Ce je obratno, je pika
Processing Mode: Dot - v Svetlejsa'
Dot timel=): 0. 1]
Interval med pikam
Dot interwal (uml: |2 / P
Dot length(mm): |0 o .. )
ot Losglalen) ——_ ||, Pikéasta dolZina za rezanje
[ ]center dot prekinjenih Crt

Samo pika na sredini

0k Cancel

Ponovno razvrs€anje podlag: klikni na gumb up, down lahko
spremeni vrstni red podlag, najprej se obdeluje zgornja podlaga.

II. 5.3 Pozicija
Nastavitev hrbtne lokacije laserske glavice po zaklju¢eni obdelavi (sedanja pozicija,
originalno sidro, stroj na niclo).

Sedanja pozicija: laserska glavica nazaj na pozicijo pred obdelavo

Originalno sidro: laserska glavica nazaj na zadnje sidro. Sidro se lahko nastavi na
ploSci.

Stroj na niclo: laserska glavica nazaj na ni¢elno pozicijo stroja.

[1.5.4 Go scale/cut scale

Slika prikazuje krog in rde€i pravokotnik zunaj njega je najmanjsi pravokotnik, klikni
na gumb »go scale« in laserska glavica ga bo obhodila.

/

Slika prikazuje krog, ki ga obddaja rdeci pravokotnik, ki je najmanjsi. Klikni na »cut scale« in
laserska glavica bo obrezala pravokotnik.

II. 5.5 Start, pause, stop, shrani pod datoteko UFile, izvozi iz datoteke Ufile, prenesi
Zacni/start: grafiko vnesi v stroj za obdelavo.

Miruj/nadaljuj (pause/continue): klikni na »miruj« in obdelava bo prekinjena nato spet klikni
na gumb za nadaljevanje (ang. »continue«).



Zasustavi/stop: zaustavi trenutno obdelavo.

Shrani pod datoteko UFile:

Shrani trenutno datoteko kot RD format za uporabo nespletne obdelave (za popolno nespletno
obdelavo jo lahko kopiramo na drug spomin).

Na primer: shrani krog.

Savein: | (B} Desklop v QT mE

u:'lM’f Documents

_,5 My Computer
€My Metwork Flaces
I[IRDCAMSetUp ¥3,0,2

Iy SendCommand

ket

m bar.rd

File name:

Save as type: | *rd w

Izvoz iz datoteke Ufile:

Izvozi nespeltno datoteko (RD format)

Potem ko ste shranili nespletno datoteko, kliknite na »UFile output« in izberite datoteko RD
za obdelavo.

Prenesite (download):

Prenesite datoteko na spomin kontrolnika, nato uporabnik lahko zac¢ne delati s strojno plosco.
I1.5.6 Izvozi izbrane grafike

Potem ko ste preverili izvoz izbranih grafik, je boljSe, da izvozite izbran del, kot pa da ne
izvozite neizbran del grafik.

I1.5.7 Optimizacija poti

Potem ko se je preverila optimizacija poti, pred izvozom samodejno optimirajte pot. Ce ste
pot Ze optimirali oziroma po optimizaciji ni potrebe, potem lahko skrajsate ¢akalni Cas, tako
da ne preverjate optimizacije poti.

I1.5.8 Gibanje osi

Pri nadzoru osi lahko vskai¢ nadziramo eno os.

Nastavite lahko informacije za gibanje osi, vkljucno z dolZino gibanja, hitrostjo, vklopljenim
in izklopljenim laserjem in lasersko mo&jo. Ce preverite gibanje iz prvotne to¢ke, potem
offset pomeni offset stroja na ni¢elno to¢ko. Ce gibanja od zaGetka ne preverjate, potem offset
pomeni offset na trenutno pozicijo.

Pomnite: absolutna pozicija ni negativna v celotni $irini glede na predpise kontrolnika. Ce
preverja$ gibanje od zaCetkan in nastavi§ negativno vrednost offseta, s ebo stroj dotikal
omejevalnika.



I1. 6. poglavje
POGOSTO ZASTAVLJENA VPRASANJA

Potem ko se je obdelava zacela, se stroj ne premika, nima moten;j in ne gubi dele grafikov.
e Preveri, ali so podatki grafike izven okvirja. Podatki za okvirjem se ne bodo rezali.
e Preveri nastavitev pozicije laserske glave

I1.6.2 Pri uvazanju datoteke programska oprema samodejno izklopljena

Ce je sistem delovanja XP, prosim, prverite, ali je nastavljeno stikalo.

I1.6.3 TakojSnja strojna ploSc¢a (manj odbojne razdalje)

Preveri hitrost rezanja v strojnem parametru. Obi¢ajno rezalna hitrost ni 8000.
Poskrbi za to, da grafike niso bluzu meje strojnega okvirja.

I1.6.4 Obdelava grafik in sestrsko zrcalo dejanskim grafikom

Preveri »osno zrcalo« v okencu za splosne nastavitve (glej 4.2 sploSne nastavitve).



IIT NAVODILA ZA UPORABO LASERSKE PROGRAMSKE OPREME ZA
GRAVIRANIJE IN REZANJE V.3.0

Uvod

Imamo dve vrsti laserske programske opreme za rezanje in graviranje. Ena temelji na
neposrednem izvozu programske opreme (v nadaljevanju laser CorelDraw), drugi pa temelji
na izvozu programske opreme AutoCAD (v nadaljevanju laser AutoCAD). Sledi predstavitev
obeh laserjev.

111
1. poglavje
PREDSTAVITEV LASERJA CORELDRAW

Znacilnosti laserja CorelDraw

Uporablja se veCinoma v nadzoru gibanja. Je pomemben del nadzora gibanja laserja.
Laserskemu numericnemu kontrolnemu stroju daje uc¢inkovit nadzor ter dokonca naloge v
skladu z Zeljami upravljalca. Spodaj so podane njegove funkcije in znacilnosti:

1. Laser CorelDraw je vtikalni modul names¢en v CorelDraw-u. Ima mocne funkcije
nacrtovanja in urejanja, kot sta na primer nastavljenje velikosti graficne podobe in
sukanje/vrtenje v krogu.

2. Podpira skoraj vse oblike zapisa datoteke, vklju¢no z vektoprskimi oblikami zapisa
(kot sta Plt in Al) in bitno mapo (kot je BMP).

3. Prav tako podpira obliki zapisa datoteke DST in DSB (ki jih CorelDraw sam ne
podpira), in sicer z uvozom funkcije samega modula CorelDraw_Laser.

4. Podpira funkcijo sinteziranja (raCunalniSko podprto spuscanje glasov) z uporabo
uvozne funkcije CorelDraw, s Cimer sta za vedno omogocena izvoz in obdelava
mnogih dokumentov.

II1.1.2 Okoljski pogoji

Priporoc¢ljivo nad CPU586, PIII, PIV

Priporocljiv spomin nad 1 G

Priporocljivi Windows 2000 XP, Vista, WIN7, XP

Podpira programsko opremo CorelDraw 11 in CorelDraw 12, CorelDraw 13 in CorelDraw 14.

IT1. Namestitev in zagon

II1. 1.3.1 Namestitev

Pred namestitvijo laserja CorelDraw Laser morate na vasem racunalniku imeti namesScen
CorelDraw 11 ali CorelDraw 12. Ce ga nimate, potem najprej namestite CorelDrawl1 ali
CorelDraw12 na vas racunalnik.

Odprite CorelDraw11 ali CorelDraw 12, CorelDraw13 in CorelDraw14 in pred namestitvijo
zakljucite konfiguracijo.
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Slika 1-1

Kot prikazuje slika 1-1, pojdite v meni CorelDraw-a, izberite meni CorelDraw, nato kliknite
na orodja in opcije (ang. tools->options) in pojavil se bo meni, ki je prikazan na sliki 1-2.

Loz
-~ {zeneral )
- Display Menu Bar Size
L Edit E Context Menu Bar Button: Border:
-~ Smap to Objects Skatus Bar
- Dynamic Guides Standard Small 1
Warnings Property Bar
Toolb

;BA E T::t o Diefault Butkon Appearance
e oae D Zaom |D F It
—Memory =rau
- Flug-Tns [ Inkernet
- Text [ Prink Merge
- Toolbox [ Transform Other
[=-Customization Visual Basic For Applicati. ., Show kitle when toolbar is floating

. Command Bars

Commands
- Color Palette
‘. Application
[+ Doecument
[+ Flobal

[ QK ]I_ Cancel J[ Help

Slika 1-2



Kot prikazuje slika 1-2, izberite »vizualne osnove za uporabo« (ang. Visual Basic for
applications) in kliknite »OK«.

Slika 1-3 prikazuje glavni meni CorelDraw-a:

Orodna vrstica Visual Basic for
Tl<usd applications (=163
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Konfiguracija CorelDraw je zakljucena, zaprite CorelDraw.
Da bi zagotovili gladko konfiguracijo, vam predlagamo, da najprej zaprete protivirusno
programsko opremo.

ROCAMS e tup
Y3002 exe
L VEDICAMZ. 0 3.00 In. .. o ) )
Dvakrat kliknite na - in pojavil se bo meni za namestitev
programske opreme, kot prikazuje slika 1-4:

Welcom to use (X1 B ) Namesti USB

Kljuc
Install Driver/3EshaEdE /‘/

byl VKljuCuje dve opciji: laser
CorelDraw_Laserin laser
Type/2EH . |Corellraw Lazer % | AutoCAD Taser. Izberi CorelDraw Laser

Lanuage/iBE : kaljuéuje tri opcije: poenostavljeno
kitajS€ino (Simplified Chinese),

[ Locate install path/EEHIEE tradicionalno kitaj$¢ino (Traditional
Chinese) in anglescCino (English).
Ingtall/3E8 Exit/iEH | Prosim, izberite jezik programske

opreme, ki ga potrebujete.

Za namestitev klikni na ta
gumb




5. Kliknina [nstall Driver/3k/iZ#%] za namestitev USB kljuga. Ce se pojavi
okence z opominom v zvezi z namestitvijo strojne opreme, klikni »nadaljuj«
(ang. »continue«), dokler se namestitev ne zakljuci.

Hardware Installation

' E The software wou are inztalling far this hardware;
L

I15EB Sernial Cornvverter

haz not pazzed ‘Windows Logo testing to venfy itz compatibility
with Windows XP. [Tell me why thiz testing is important. |

Continuing your installation of this software may impair
or destabilize the correct operation of your zystem
either immediately or in the future. Microzoft strongly
recommends that you ztop thiz installation now and
contact the hardware vendor for software that has
pazzed Windows Logo teshing.

[ Continue Aryaay ] EﬁéTDF‘InstallatiDn |

Po namestitvi se pojavi naslednje okence, ki sporo€a uspesSno namestitev USB
kljuCev:

RlLaserSetUp P§|

Ll
“!J‘) FTDI drivers have been install successfully installed!

Kot prikazuje slika 1-4, izberi CorelDraw_Laser, izberi jezik programske opreme in
klikni na namestitev. Pojavil se bo meni o uspesni nastavitvi, ki ga prikazuje slika 1-5.

RlLaserSetUp E|

\lr) Install Finish!

Slika 1-5: obvestilo o dokonc¢anju nastavitve.

6. Dokoncanje nastavitve



[ll. 1.3.2 Zagon (ang. Startup)
Odpri CorelDraw 11 ali CorelDraw 12 in pojavil se bo glavni meni CorelDraw-a, ki ga
prikazuje slika 1-6:

Tl ety ) 12 — [Geagicicl] M=
||-] File Edit V¥iew Layout jrrange Effectz Bitmaps Text Toolz Window Help - 8 x
low i A - ) oo b EIN @
” a4 IE géggmm | & ufn Units: | milimeters G 2,54 mm g: ggg mm # @ Eta okl
TJ:'\'_.??U.........ZUIU.........IUIU.........?.........1?0.........ZEIIU.........3?0.........4?0.........['15”".“.&?’:.
o ® — |Orodna vrstica uporaba laserja

&, ! > l |

E " 2+ Gumb za lasersko obdelavo

JIE ' )

| Gumb za namestitve ;

B _] |

e |5

| Gumb za uvoz podatkov DST/DSB

2, I

e

P X M
@,|FM + 10f1  + M Pagel [ m

> ><
( 278,880, 335.665 )  Mext click for Drag/Scale; Second click for RokatefSkew; Dbl-clicking tool selects all objects; 5... @ - 4

Slika 1-6: glavni meni CorelDraw

Orodno vrstico »uporaba laserja« (ang. »Laser Using«) lahko vlecete samostojno na
pozicijo, ki je po vasi meri, na primer, kot prikazuje slika 1-7:



Orodna vrstica uporaba laserja-Laser Using

Ao

Tl cucalyiif 12 — [Gengiiel] \_i\.!]ﬂ‘

”-] File Edit View Layout Arrange Effects Bitmaps Text Tools Nindow  Help - O x

lppeavere o l@ua-gie @ vaExe i o|oms

” Ad D ;g 2}\0'2 fnm 29, |E||:| Igl Units: | millimeters r @ 2.54mm 2 a, 6:32”‘ g# 4131 .El |£§|HE |;I§
Gumb laserska obdelava-Laser Processing L Pi“‘.m?‘g

Sk B

=)

" Gumb za namestitve-Settings
§ Gumb za uvoz podatkov DST/DSB %
[+]

P B IPFEODORSR
10

millimeters

[~
14 + 1of1 + MY Pagel 1] i B
] ><

[ |

{ 335.632, 352,567 )  Mext click for Drag/Scale; Second click for Rotate/Skew; Dbl-clicking tool selects all objects; 5., @




